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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the “MS2690A/MS2691A/MS2692A Signal 
Analyzer Operation Manual (Mainframe Operation)”, 
“MS2830A Signal Analyzer Operation Manual 
(Mainframe Operation)” or “MS2840A Signal Analyzer 
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“MS2690A/MS2691A/MS2692A Option 020 Vector 
Signal Generator (Operation)” and 
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(Operation)” Please also refer to either of these 
documents before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of 
the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu 
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 
This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 
take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note. The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 

MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Signal Analyzer 
Vector Signal Generator 
Operation Manual (IQproducerTM) 
 
25 April 2007 (First Edition) 
19 October 2018 (11th Edition) 
 
Copyright © 2007-2018, ANRITSU CORPORATION. 
All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event of this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the PDF version. 
 
 



 

iv 

 

 

 
 

Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 

 
 

Trademark and Registered Trademark 
IQproducerTM is a registered trademark of Anritsu Corporation. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Protection Against Computer Virus Infections 

Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB memory stick and CF memory card) you 
want to connect to your computer. 
 
When using this software and connecting with the measuring instrument 
• Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB memory stick and CF memory card). 

• Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

 
 
 

Cautions on Proper Operation of Software 

This software may not operate normally if any of the following operations 
are performed on your computer: 
• Simultaneously running any software other than that recommended or 

approved by Anritsu 
• Closing the lid (Laptop computer) 
• Turning on the screen saver function 
• Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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About This Manual 
 Composition of Operation Manuals 

The operation manuals for the MS2690A/MS2691A/MS2692A, MS2830A 
or MS2840A Signal Analyzer are comprised as shown in the figure below. 
 

 

Vector Signal Generator Operation Manual (IQproducerTM) 

Vector Signal Generator Operation Manual (Standard Waveform Pattern) 

Communication System Supporting IQproducerTM Operation Manual 

MS2690A/MS2691A/MS2692A 
Signal Analyzer  
Option 020: Vector Signal 
Generator Operation Manual 
(Operation) 

MS2830A/MS2840A  
Signal Analyzer Vector Signal 
Generator Operation Manual 
(Operation) 

Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer  
Option 020: Vector Signal 
Generator Operation Manual 
(Remote Control) 

MS2830A/MS2840A  
Signal Analyzer Vector Signal 
Generator Operation Manual  
(Remote Control) 

Or 

MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual  
(Main Frame Operation)

MS2690A/MS2691A/MS2692A and MS2830A/MS2840A/MS2850A  
Signal Analyzer Operation Manual (Main Frame Remote Control) 

MS2840A Signal Analyzer Operation Manual  
(Main Frame Operation) 

Or 
MS2830A Signal Analyzer Operation Manual  
(Main Frame Operation)
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 Signal Analyzer Operation Manual (Mainframe Operation) 

 Signal Analyzer Operation Manual (Mainframe Remote Control) 

These manuals describe basic operating methods, maintenance 
procedures, common functions, and common remote control of the signal 
analyzer mainframe. 
 

 Vector Signal Generator Operation Manual (Operation) 

This manual describes functions, operating methods, and so on of the 
vector signal generator (option). 
 

 Vector Signal Generator Operation Manual (Remote Control) 

This manual describes remote control of the vector signal generator 
(option). 
 

 Vector Signal Generator Operation Manual (IQproducerTM) (This 

manual) 

This manual describes functions, operating methods, and so on of the 
IQproducer, which is application software used with the vector signal 
generator (option). 
 

 Vector Signal Generator Operation Manual (Standard Waveform 

Pattern) 

This manual describes details on the standard waveform pattern data 
used with the vector signal generator (option). 
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O
verview

This chapter provides an overview of the IQproducerTM for the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A Signal Analyzer 
Vector Signal Generator option. 
 

1.1 Overview .................................................................... 1-2 
1.2 Functions ................................................................... 1-3 

1.2.1 Signal generation application corresponding to 

communications system ................................ 1-3 
1.2.2 CCDF graph display function ........................ 1-3 
1.2.3 FFT graph display function ............................ 1-3 
1.2.4 File conversion function ................................. 1-3 
1.2.5 Time domain graph display function .............. 1-4 
1.2.6 Clipping function ............................................ 1-4 
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1.1 Overview 
The IQproducerTM is Windows application software used to generate a 
modulated waveform pattern to be used by the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A Signal Analyzer 
Vector Signal Generator option. 

Note that purchase of a license key corresponding to the serial number of 
your Vector Signal Generator option is required when actually using a 
waveform file with the Vector Signal Generator option, a file generated 
by the modulated waveform pattern generator IQproducerTM (hereinafter, 
referred to as “signal generation application”) corresponding to each 
communication system. 

The IQproducerTM also enables the Complimentary Cumulative 
Distribution Function (CCDF) results and Fast Fourier Transform (FFT) 
results of a generated modulated waveform pattern to be displayed in a 
graph. In addition, it can convert an ASCII-format waveform pattern 
generated by your signal generation application tool to a binary-format 
waveform pattern that can be used in the Vector Signal Generator option. 

This operation manual describes the functions of the IQproducerTM, 
except for the signal generation application. 
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1.2 Functions 
1.2.1 Signal generation application corresponding to communications 

system 
Signal generation applications that generate modulation waveform 
patterns are provided for each communications system. For detailed 
information on the operations and functions of these applications, refer to 
the operation manual of each signal generation application. 

1.2.2 CCDF graph display function 
The IQproducerTM can read a modulation waveform pattern generated by 
each signal generation application and display it in the CCDF graph with 
up to eight traces. 

The CCDF graph displayed on the screen can be printed out and saved 
into a CSV-format file. 

1.2.3 FFT graph display function 
The IQproducerTM can read a modulation waveform pattern generated by 
each signal generation application and display it in the FFT graph with 
up to four traces. 

The FFT graph displayed on the screen can be printed out and saved into 
a CSV-format file. 

1.2.4 File conversion function 
The IQproducerTM can convert an ASCII-format waveform pattern 
generated by simulation software or other external software to a 
binary-format modulation waveform pattern file that can be used in the 
Vector Signal Generator option.  
In addition, it can convert a digitized file that is created by the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A Signal Analyzer 
using the digitize function, and convert a waveform pattern for the 
MG3700A/MG3710A Vector Signal Generator (hereinafter, referred to as 
“MG3700A/MG3710A”) into a binary-format modulation waveform 
pattern that can be used in the Vector Signal Generator. Conversely, a 
waveform pattern for the MS269x/MS2830/MS2840 can also be converted 
into a file that can be used in the MG3700A/MG3710A.  
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1.2.5 Time domain graph display function 
The IQproducerTM can read a modulation waveform pattern generated by 
each signal generation application and display it in the time domain 
graph with up to four traces. 

1.2.6 Clipping function 
This function performs clipping processing for a waveform pattern 
generated by each signal generation application. 
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This chapter describes how to install/uninstall the IQproducerTM to a PC. 
 

2.1 Operating Environment .............................................. 2-2 

2.2 Installation/Uninstallation Procedure ......................... 2-3 

2.2.1 Installation procedure .................................... 2-4 

2.2.2 Upgrade procedure ........................................ 2-6 

2.2.3 Uninstallation procedure ................................ 2-7 
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2.1 Operating Environment 
The IQproducerTM requires the following environment. 

Table 2.1-1  Operating Environment 

PC 

OS 

IQproducerTM Version 16.01 or earlier 

Windows XP/Windows Vista/Windows 7 
IQproducerTM Version 17.00 or later 
Windows 7/Windows 10 

CPU At least 1 GHz or faster Pentium III or 
equivalent 

Memory 512 MB or more 

Hard disk 5 GB or more free space in the drive where the 
IQproducerTM is to be installed.  

Peripheral device 

Display Displays with a resolution of 1024 × 768 pixels 
are best viewed using a small font setting. 

 
Although the IQproducerTM can be installed and operated in the 
MS2690A/MS2691A/MS2692A or MS2830A/MS2840A, operations of the 
measurement functions are not guaranteed when the IQproducerTM is 
running on the MS2690A/MS2691A/MS2692A or MS2830A/MS2840A. 
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2.2 Installation/Uninstallation Procedure 
The IQproducerTM can be installed interactively by activating the setup 
program. 

If resident virus check programs are running on your PC, exit them 
before activating the IQproducerTM setup program, as well as other 
Windows applications in progress. 

Note: 

If you upgrade the IQproducerTM after the version 3.00 (hereafter 
referred to as “new software”) in PC in which the IQproducerTM 
before version 2.01 (hereafter referred to as “old software”) is 
installed, please execute the setup file of the old software and 
uninstall it before executing the setup file of new software.  
However, if the short file name support was disabled on your 
Windows, old software cannot be uninstalled.  In this case, 
instead of uninstalling the old software, execute the setup file of 
the new software and specify the installation folder of the old 
software for the Destination Folder, thereby installing the new 
software, while overwriting the old one. 

Note: 

This software of version 13.00 or later requires you to have 
installed Microsoft Visual C++ 2010 Redistributable Package (x86). 
In addition, this software of version 13.00 or later does not work on 
Windows2000. 

Note: 

When you run the setup program for IQproducerTM version 14.02 
or later (hereafter referred to as “new software”) on the PC to 
which IQproducerTM version 14.01 or earlier (hereafter referred to 
as “old software”) has been installed, the automatic uninstallation 
of the old software starts. 
When the old software has been successfully uninstalled, the 
installation of the new software starts. 

Note: 

To downgrade from IQproducerTM version 14.02 or later (hereafter 
referred to as “new software”) to IQproducerTM version 14.01 or 
earlier (hereafter referred to as “old software”), uninstall the new 
software before installing the old software. 
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2.2.1 Installation procedure 
Follow the procedure below to install the IQproducerTM on the hard disk 
of your PC. 

<Procedure> 

1. Double-click the SETUP.EXE file in the folder where the files of the 
IQproducerTM are stored. 
When installing the IQproducerTM using the setup disk, double-click 
the SETUP.EXE file in the \IQproducer directory of the setup disk. 

2. If Microsoft Visual C++ 2010 Redistributable Package (x86) is not 
installed to your PC, start the installation of the package. 

 
Figure 2.2.1-1  Installation of the Microsoft Visual C++2010 

Redistributable Package 
 

3. When Microsoft Visual C++ 2010 Redistributable Package (x86) 
version 10.0.30319 or later has been already installed, the following 
confirmation message may appear. If you see the confirmation 
message, continue the installation. 

 

Figure 2.2.1-2  Confirmation Message That Appears When the New Version 
of Microsoft Visual C++2010 Redistributable Package Is Installed 

 

 To check the version information of Microsoft Visual C++ 2010 
Redistributable Package (x86), click Control Panel, and then click 
Uninstall a program. 
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4. The IQproducerTM setup program starts. When “Welcome to the 
InstallShield Wizard for IQproducer” is displayed on the screen, 
click the Next> button. 

5. The License Agreement screen is displayed.  Read the license 
agreement terms, and click the Yes button if you agree with the 
contents. 
Note that the installation procedure will not continue unless you 
agree with the license agreement terms. 

6. The directory path in which the software will be installed is 
displayed in the Destination Folder field. 
When changing the installation folder, click the Browse… button to 
open the directory change dialog box, and specify the desired folder.  
In this event, be sure to confirm that there is enough free space in 
the drive where the target folder belongs to.  For free space, refer to 
Section 2.1 “Operating Environment.” 
The IQproducerTM generates temporary data under the installation 
folder. 

7. After specifying the installation folder, click the Next> button to 
display the folder for storing the program icon in the program folder 
selection window.  It is also possible to change from this window the 
folder for storing the program icon.  Click the Next> button to start 
installation. 

8. When “InstallShield Wizard Complete” is displayed, click the Finish 
button. 
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2.2.2 Upgrade procedure 
Follow the procedure below to upgrade the IQproducerTM. 

The upgrade process is run by double-clicking the SETUP.EXE file for 
the later version than the version currently installed on your PC. 

<Procedure> 

1, Double-click the SETUP.EXE file in the folder where the 
IQproducerTM is stored. To install using the setup disk for the 
IQproducerTM, double-click the SETUP.EXE file stored in the 
\IQproducer folder on the setup disk. 

2. The installation of Microsoft Visual C++ 2010 Redistributable 
Package (x86) begins in the same way as described in step 2 of 2.2.1 
“Installation procedure”. Follow step 2 of 2.2.1 “Installation 
procedure”. 

3. Follow step 3 of 2.2.1 “Installation procedure”. 

4. When you see the following message after the IQproducerTM setup 
program starts, click the Yes button: 
“The setup will perform an upgrade of ‘IQproducer’. Do you want to 
continue?” 

5. When you see the following message, click the Next button to start 
upgrade: 

“Resuming the InstallShield Wizard for IQproducer” 

6. When you see the following message, click the Finish button: 
“Update Complete” 

Note: 

If you double-click the SETUP.EXE file for the older version than 
the version currently installed on your PC, the setup process is 
cancelled and you will see the following message: 
“A later version of ‘IQproducer’ is already installed on this machine. 
The setup cannot continue.” 
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2.2.3 Uninstallation procedure 
Follow the procedure below to uninstall the IQproducerTM from the hard 
disk of your PC. 

<Procedure> 

1. Click the Start button on the Windows task bar, point Setting, and 
click Control Panel. 

2. Double-click the Add or Remove Programs icon. 

3. On the Change or Remove Programs tab, click the IQproducer item 
in the Currently Installed Programs list to display it highlighted. 

4. Click the Change/Remove button. 

5. When the uninstall program starts, read the message, and click the 
OK button. 

6. A confirmation message may be displayed during uninstallation, 
asking whether to remove a shared file. Select NO unless it is not 
certain whether the indicated file is shared by any other programs.  
Some programs may not function correctly if a necessary shared file 
is removed inadvertently. 

7. When “Uninstallation Complete” is displayed, click the Finish 
button. 

Note: 

If a shared file is removed, there is a possibility that other 
application programs may not function.  Do not remove the shared 
file unless it is not certain whether the indicated file is shared or 
not. 
Even if a shared file is removed inadvertently, it may be restored 
by installing the IQproducerTM again. 
If the short file name support was disabled on your Windows, 
IQproducerTM before version 1.02 cannot be uninstalled. 
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This chapter describes the operations specifically important for operating 
the IQproducerTM on Windows. 
 

3.1 Operations for Menu .................................................. 3-2 
3.1.1 Operations using mouse................................ 3-2 
3.1.2 Operations using keyboard ........................... 3-2 
3.1.3 Operations using up and down cursor keys .. 3-3 

3.2 Operations for Dialog Box .......................................... 3-4 
3.2.1 File Open and Save as… .............................. 3-4 
3.2.2 Entering numeric value and character string . 3-6 
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3.1 Operations for Menu 
3.1.1 Operations using mouse 

 Description for mouse operation 
• Point: To move a mouse and place the mouse pointer onto 

the operation target object. 
• Click: To press a mouse button and release it 

immediately. The button indicates a left button 
unless otherwise specified. 

• Double click: To click a mouse button twice quickly. The button 
indicates a left button unless otherwise specified. 

• Drag: To press a mouse button and then move the mouse 
while holding down the button. The button 
indicates a left button unless otherwise specified. 

 

 

Figure 3.1.1-1  Screen explanation 
 

<Procedure> 
1. Click a menu on the menu bar (File, Edit, etc.) to display the 

pull-down menu. 

2. Select an item to be executed from the displayed pull-down menu, 
and click it. 
 

3.1.2 Operations using keyboard 
<Procedure> 
1. Press Alt . 

2. Select a menu on the menu bar using the right and left cursor keys 
(←/→), and press Enter  or the down cursor key (↓) to display the 
pull-down menu. 

3. Select an item to be executed from the displayed pull-down menu, 
and then press Enter . 
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3.1.3 Operations using up and down cursor keys 
<Procedure> 
1. Select an item to be executed using the up and down cursor keys 

(↑/↓) and press Enter . 
An item can also be selected by pressing the underscored character 
in that item on the menu bar and pull-down menus. Such a key is 
referred to as “accelerator key.” For example, the accelerator key for 
the Recall Parameter file item is R , and for Exit, E . When 
selecting an item on the menu bar, however, it is necessary to 
activate the menu bar (an item is highlighted when the menu bar is 
activated) by pressing Alt . 
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3.2 Operations for Dialog Box 
3.2.1 File Open and Save as… 

 

Figure 3.2.1-1  Dialog box 
 

<Procedure> 
1. Select a drive or folder from the Look in box (for opening a file) or 

the Save in box (for saving a file). 
For the mouse operation, click the Look in or Save in box to open the 
list of drives and folders. Select the target drive or folder from the 
list and click it to switch the display (the contents of the selected 
drive/folder are displayed). 
For the keyboard operation, press Tab  several times to highlight 
the Look in or Save in box, then press the up or down cursor key 
(↑/↓) to open the pull-down list of drives and folders. Use the cursor 
keys (↑/↓/←/→) to select the target drive or folder from the list and 
then press Enter . 

2. Select a file type from the Files of type text box. 
For the mouse operation, click the Files of type text box to open the 
list of file types. Select the target file type from the list and click it. 
For the keyboard operation, press Tab  several times to highlight 
the Files of type text box, then press the up or down cursor key (↑/↓) 
to open the pull-down list of file types. Use the cursor keys 
(↑/↓/←/→) to select the target file type from the list and then press 
Enter . 
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3. Enter into the File name box the name of a file to be opened or 
saved. 

4. When opening a file by the mouse operation, click the file to be 
opened from the displayed files. The name of the selected file is 
displayed in the File name text box. Click the Open button to open 
the selected file.  
The contents of a folder can also be displayed in a similar manner. 
Click a folder and then click the Open button to open the contents of 
the selected folder. 
When opening a file or folder by the keyboard operation, press 

Tab  several times to move the cursor to the folder/file display 
field (highlighted when selected), and use the cursor keys (↑/↓/←/→) 
to select the file or folder to be opened. Then press Enter  to open 
the selected file/folder. 

5. When saving a file with a specified name, highlight the File name 
text box by clicking it (mouse operation) or pressing Tab  several 
times (keyboard operation). 
Next, type the desired file name in the text box. 
Then click the Save button (mouse operation) or press Enter  
(keyboard operation) to save the file with the specified name. 

6. The “Open” and “Save As” operations can be cancelled halfway. For 
the mouse operation, click the Cancel button. For the keyboard 
operation, press Tab  several times to move the cursor to the 
Cancel button and press Enter . 
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3.2.2 Entering numeric value and character string 
<Procedure> 
1. When entering a numeric value, click the desired numeric value 

entry text box or move the cursor to the desired numeric value entry 
text box by pressing Tab  several times. 
Enter a numeric value from the keyboard or numeric keypad. Then 
click the OK button or press Enter  to input (finalize) the entered 
value. 

2. When entering a character string, click the desired character string 
entry text box or move the cursor to the desired character string 
entry text box by pressing Tab  several times. 
Enter a character string from the keyboard. Then click the OK 
button or press Enter  to input (finalize) the entered character 
string. 

3. The numeric value or character string entry operation can be 
cancelled halfway. For the mouse operation, click the Cancel button. 
For the keyboard operation, move the cursor to the Cancel button by 
pressing Tab  several times and press Enter . 
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This chapter describes the items that the users should understand when 
actually operating the IQproducerTM, including the names of parts in 
each screen, operations in the CCDF/FFT graph screens, file conversion 
settings in the Convert screen, and functions in the data transfer screen. 
 

4.1 Starting/Exiting IQproducerTM ..................................... 4-4 

4.1.1 Starting Software .............................................. 4-4 

4.1.2 Exiting Software ................................................ 4-5 

4.2 Common Platform Screen ............................................ 4-6 

4.3 CCDF Graph Display .................................................. 4-10 

4.3.1 Activation ........................................................ 4-10 

4.3.2 CCDF graph display screen ........................... 4-11 

4.3.3 Displaying CCDF graph .................................. 4-13 

4.3.4 Deleting CCDF graph ..................................... 4-16 

4.3.5 Displaying Gaussian trace .............................. 4-17 

4.3.6 Interaction with signal generation application 

(Quick Add Mode) ........................................... 4-17 

4.3.7 Selecting mouse interaction in CCDF graph 

display area .................................................... 4-18 

4.3.8 Moving graph cursor ....................................... 4-19 

4.3.9 Changing graph scale..................................... 4-20 

4.3.10 Printing/saving graph data .............................. 4-23 

4.4 FFT Graph Display ..................................................... 4-24 

4.4.1 Activation ........................................................ 4-24 

4.4.2 FFT graph display screen ............................... 4-24 

4.4.3 Displaying FFT graph ..................................... 4-26 

4.4.4 Deleting FFT graph ......................................... 4-29 

4.4.5 Changing graph display area and axis plot 

interval ............................................................ 4-30 
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4.4.7 Selecting mouse interaction in CCDF graph 
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4.5.6 Input file format ............................................... 4-54 
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4.1 Starting/Exiting IQproducerTM 
4.1.1 Starting Software 

Start the IQproducerTM by following the procedures below.  

<Procedure> 

1. Click the Start button on the Windows task bar, and select All 

Programs. Then select Anritsu Corporation from the displayed 
program group and click IQproducer. 

2. When IQproducerTM is started, the Select instrument dialog box is 
displayed.  

From the Select instrument options, select the main unit model that 
will use the waveform patterns created by IQproducerTM. 

Notes: 

 MG3740A requires the digital modulation option (020/120) to 
start IQproducer™. 

 If you don’t want to see the Select instrument window again, 
select the Don’t show this window next time check box, and 
IQproducerTM will start for the selected model from the next 
startup without displaying the Select instrument window. 

3. The common platform screen is displayed after starting up the 
IQproducer™.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 4.1.1-1  Common Platform Screen 
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4.1.2 Exiting Software 
To exit IQproducer™ that are running, select Exit on the Common 
Platform Screen. In this case, a dialog is displayed to confirm stopping of 
each running tool.  

 

Figure 4.1.2-1  Exiting IQproducerTM 
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4.2 Common Platform Screen 
The common platform screen shown in Figure 4.2-1 below is displayed 
first after starting up the IQproducerTM. 

The common platform screen is a screen used to select each function of 
the IQproducerTM. Only the menu bar for selecting a function is displayed 
in this screen. 

 

Figure 4.2-1  Common Platform Screen 

 

 Description of menus 

(1) System (Cellular) tab 
Cellular system applications are displayed on the tabbed page. For 
detailed information about the signal generation applications, refer 
to the operation manual for each application.  

(2) System (Non-Cellular) tab 
 Non-cellular system applications are displayed on the tabbed page. 

For detailed information about the signal generation applications, 
refer to the operation manual for each application.  
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(3) General Purpose tab 
 General purpose applications are displayed on the tabbed page. For 

detailed information about the signal generation applications, refer 
to the operation manual for each application.  

 

Figure 4.2-2  General Purpose Tab 

 

1 TDMA 

TDMA applications are displayed.  
Waveform patterns corresponding to TDMA system 
specifications are created in this application.  

2 Multi-Carrier 

Multi-Carrier applications are displayed.  
Modulated waveform patterns corresponding to Multi-Carrier 
system specifications are created in this application.  

3 Convert 

The Convert screen is displayed.  
In the Convert screen, ASCII-format waveform patterns 
generated by simulation software, digitized files created by the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A using the 
digitize function, and waveform patterns formatted for the 
MS269x, MS2830A or MS2840A can be converted into a file so 
as to be used in the mainframe. Conversely, a waveform pattern 
for the mainframe can also be converted into a file that can be 
used in the MS2690A/MS2691A/MS2692A, MS2830A or 
MS2840A.  
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4 Clipping 

The Clipping setting screen is displayed.  
Clipping processing can be performed in the Clipping setting 
screen, for a waveform pattern generated by each signal 
generation application.  

 
(4) Simulation & Utility tab 

Application menus of simulations and utilities are displayed on this 
tabbed page.  

 

Figure 4.2-3  Simulation & Utility Tab  

 

1 CCDF 

Displays the CCDF Graph Monitor screen.  
The CCDF of a generated waveform pattern is displayed in a 
graph.  

2 FFT 

Displays the FFT Graph Monitor screen.  
The spectrum where FFT processing is performed for a 
generated waveform pattern is displayed in a graph.  

3 Time Domain 

Displays the time domain graph display screen.  
The time domain waveform of a created waveform pattern can 
be displayed in a graph.  
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(5) Change Instrument button 

Provided to display the Select instrument dialog box at the next 
startup. A message is displayed indicating that the IQproducerTM 

must be restarted to change the target model.  

(6) Help button 

The version information of the IQproducerTM is displayed.  

(7) Exit button 

Exits from this software. This menu also closes all the other screens 
for IQproducerTM functions if displayed.  
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4.3 CCDF Graph Display 
The Complementary Cumulative Distribution Function (CCDF) of a 
waveform pattern generated by a signal generation application can be 
displayed. 

In a CCDF graph, the signal peak power/average power is displayed on 
the X axis, and on the Y axis, the cumulative probability that the peak 
power / average power of the signal is equal to or less than the value on 
the X axis is displayed. Distribution of peak powers of various 
modulation signals can be displayed in a screen. This screen is useful, for 
example, for estimating the output waveform distortion characteristics 
when a generated signal is input from the Vector Signal Generator option 
to a power amplifier or other devices. 

4.3.1 Activation 
Select CCDF from the Simulation & Utility tab on the common platform 
screen. The CCDF graph display screen is displayed separately.  
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4.3.2 CCDF graph display screen 

 

Interaction with signal
generation application

Menu

Legend

Trace addition/
deletion

Crest factor

Mouse interaction
setting

Scale setting

Cursor posit ion
sett ing

CCDF graph
display area

Sampling points
setting

Sampling range
setting

 

Figure 4.3.2-1  CCDF graph display screen 

 

 Description of items in CCDF graph display screen 

(1) Menu 
Trace addition, graph print out, screen copy, graph data saving into 
a CSV format file, and CCDF graph display close can be executed. 

(2) Legend 
File name display for an added trace, selection of a displayed trace, 
and selection of a trace to be added/deleted can be executed. 

(3) CCDF graph display area 
A CCDF graph is displayed in this area. Cursor move and graph 
zoom-in display can be executed. 

(4) Crest Factor 
The ratio between the peak value and RMS value of the selected 
trace is displayed. 

(5) Add/Delete (trace addition/deletion) 
A trace can be added/deleted. 

(6) Sampling Points 
The number of samples calculated by reading the selected trace is 
displayed. Different sampling points can be set by changing the 
value in this text box. 
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(7) Sampling Range 
The sampling range for the selected trace is displayed. A different 
sampling range can be set by changing the value in this text box. 

(8) Cursor Position 
The current cursor position is displayed. The cursor position in the 
CCDF graph display area can be specified by entering a value in 
either PAR or Probability text box. 

(9) Quick Add Mode (interaction with signal generation application) 
Settings for addition of a waveform pattern generated by a signal 
generation application to the CCDF graph display in conjunction 
with the signal generation application can be executed. 

(10) Scale setting 
The scale of the X and Y axes in the CCDF graph display area can be 
changed. 

(11) Mouse Interaction 
The mouse operation in the CCDF graph display area can be set to 
either the cursor move function or the zoom-in function. 
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4.3.3 Displaying CCDF graph 
A waveform pattern generated by a signal generation application of the 
IQproducerTM can be read and displayed in a CCDF graph. 

 CCDF graph display procedure 

<Procedure> 

1. Click one of the option buttons in the Legend dialog box to select the 
trace color of the waveform pattern in the CCDF graphical area.  

 

Select whichever.

 

Figure 4.3.3-1  Selecting radio button in Legend 

 

2. Click the Add button. 

 The Add button is disabled and cannot be selected when another 
waveform pattern is already selected. In this event, delete the 
selected waveform pattern or click another radio button in the 
Legend field. 
Otherwise, click Add Trace from the File menu. 

 

 

Figure 4.3.3-2  Add button 

 

 

Figure 4.3.3-3  Add Trace in File menu 
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3. Click the  button in the Add Trace screen, and select a 
waveform pattern for which a CCDF graph is displayed. Next, set 
the number of target data samples and the target data area for 
displaying the CCDF graph, in the Sampling Points and Sampling 

Range text boxes, respectively. If the target area includes the RF 
Gate OFF area (RF output is set to off) at this time, the RF Gate 
OFF interval can be excluded from the CCDF graph display target 
by selecting the Exclude RF Output Off Sample check box. 

 

Figure 4.3.3-4  Add Trace screen 

 

4. Click the OK button on the Add Trace screen to read the waveform 
pattern. A graph calculation progress screen as shown below is 
displayed while reading the waveform pattern. 

 

Figure 4.3.3-5  Graph calculation progress screen 
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 If the Cancel button is clicked during the graph calculation, the 
calculation is interrupted and waveform pattern reading is stopped. 

 When the graph calculation and waveform reading have been 
completed, the graph calculation progress screen is closed 
automatically, and the CCDF graph display screen is displayed 
again with a trace in the color selected in Legend. 
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4.3.4 Deleting CCDF graph 
The CCDF graph displayed in the screen can be deleted. 

 CCDF graph display deleting procedure 

<Procedure> 

1. In the Legend field, click the radio button of the trace to be deleted. 

 

Select whichever.

 

Figure 4.3.4-1  Selecting radio button in Legend 

 

2. Click the Delete button. 

 

Figure 4.3.4-2  Delete button 

 

 Otherwise, click Delete Trace from the File menu. 

 

Figure 4.3.4-3  Delete Trace in File menu 

 

 The trace selected in Legend is deleted. After deleting a trace, 
another waveform pattern can be selected for that item. 
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4.3.5 Displaying Gaussian trace 
A Gaussian distribution trace can be displayed in the graph when the 
Gaussian Trace check box is selected. This is useful when comparing the 
Peak Power / Average Power distribution of the waveform pattern used 
with the Gaussian distribution. 

 

Click to check.

 

Figure 4.3.5-1  Selecting Gaussian trace 

 

4.3.6 Interaction with signal generation application (Quick Add Mode) 
The method for adding a trace to the CCDF graph in conjunction with a 
signal generation application can be set and changed. This function is 
enabled only when the CCDF graph display function is activated.  

Click the Quick Add Mode button to display the Quick Add Mode dialog 
box.  

 

 

Figure 4.3.6-1  Quick Add Mode Dialog Box 

 

 When Add is selected: 

A trace is added to the CCDF graph when CCDF is selected from the 
Simulation menu or the CCDF tool button is clicked after data generation 
by the signal generation application. Note that the CCDF graph display 
will not be updated when the eight traces are all used. 
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 When Clear is selected: 

A trace is deleted from the CCDF graph and the distribution of the 
generated waveform pattern is displayed when CCDF is selected from the 
Simulation menu or the CCDF tool button is clicked after data generation 
by the signal generation application. 
 
 When Off is selected: 

The CCDF graph display will not be updated even when CCDF is selected 
from the Simulation menu or the CCDF tool button is clicked after data 
generation by the signal generation application. 
 

4.3.7 Selecting mouse interaction in CCDF graph display area 
Cursor move or graph zoom-in is selected for a dragging operation in the 
CCDF graph display area.  

Click the Mouse Interaction button to display the Mouse Interaction 
dialog box.  

Cursor The mouse is used to move the cursor.  

Zoom The mouse is used to set the zooming area.  

 

 

Figure 4.3.7-1  Mouse Interaction Dialog Box 
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4.3.8 Moving graph cursor 
The cursor displayed in the CCDF graph display area can be moved. 

 Moving cursor using mouse 

When the Cursor radio button is selected in Mouse Interaction, the 
black-line cursor is moved by dragging the cursor in the CCDF graph 
display area. 

 

Figure 4.3.8-1  Cursor in CCDF graph display area 

 

The contents displayed in Cursor Position in the CCDF graph display 
screen are updated as the cursor is moved. 
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 Moving cursor changing Cursor value 

The black-line cursor is moved by changing the value of Cursor Position 
in the CCDF graph display screen. 

 

 

Figure 4.3.8-2  Cursor Position input 

 

<Procedure> 

1. When setting the cursor position by a Peak Power / Average Power 
value, click the PAR text box and enter a value from the keyboard. 

2. When setting the cursor position by a cumulative possibility, click 
the Probability text box and enter a value from the keyboard. 
 

When the focus is moved after changing the value in the PAR or 
Probability text box as shown in step 1 or 2, the black-line cursor in the 
CCDF graph display area is moved. 
 

4.3.9 Changing graph scale 
The scale of the graph currently displayed can be changed. 

 Changing graph display area scale 

The display ranges for the X and Y axes in the CCDF graph display area 
are updated by changing the value in Scale in the CCDF graph display 
screen. 
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Figure 4.3.9-1  Scale input 

 

<Procedure> 

1. When changing the display range for the X axis, click the PAR text 
field and enter a value from the keyboard. 

2. When changing the display range for the Y axis, click the Probability 
text field and enter a value from the keyboard. 

3. When the Full Scale button is clicked, the scales for both axes are 
adjusted so that the entire of CCDF curve is displayed. 

When the focus is moved after changing the value in the PAR text box as 
shown in 1. above, the scale for the X axis in the CCDF graph display 
area is updated. 

Similarly, when the focus is moved after changing the value in the 
Probability text box as shown in 2. above, the scale for the Y axis in the 
CCDF graph display area is updated. 
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Peak Power/Avg. Power (dB)
 

Figure 4.3.9-2  Graph scale change in CCDF graph display area 

 

 Specifying display area by mouse operation 

When Zoom is selected for Mouse Interaction, pointing and dragging an 
area in the CCDF graph enlarges the selected area (enclosed by dotted 
lines). 
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4.3.10 Printing/saving graph data 
 Printing out graph display screen 

Click Print Window Image from the File menu to display the print screen. 
Set the printer, printing range, number of copies, etc., in this screen, and 
print out the CCDF graph display screen (entire of the window) from the 
printer. 

 

Figure 4.3.10-1  Print Window Image in File menu 

 

 Outputting graph data to file 

Click Export Data from the File menu to display the file save screen. Set 
the saving destination, etc., in this screen, and click the Save button. 
Lists of Peak per Average (dB) and Probability (%) are saved to a file in 
the CSV format (a text file format in which values are delimited by a 
comma). 

 

Figure 4.3.10-2  Export Data in File menu 

 

 Copying graph image on screen 

Click Copy Graph Image from the Edit menu to copy the current graph 
image on the screen to the clipboard. 

 

Figure 4.3.10-3  Copy Graph Image in Edit menu 
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4.4 FFT Graph Display 
The Fast Fourier Transform (FFT) calculation results for a waveform 
pattern can be displayed in a graph. 
The Blackman-Harris window function is used. 

4.4.1 Activation 
Select FFT from the Simulation & Utility tab on the common platform 
screen. The FFT graph display screen is displayed separately.  

 

4.4.2 FFT graph display screen 

 
Menu

Legend

FFT graph display
area

Trace addition/
deletion

FFT points setting

Mouse interaction
setting

Interaction with signal
generation application

Scale setting

Cursor position
setting

Sampling range
setting

 

Figure 4.4.2-1  FFT graph display screen 

 

 Description of items in FFT graph display screen 

(1) Menu 
Trace addition, graph print out, screen copy, graph data saving into 
a CSV format file, and FFT graph display close can be executed. 

(2) Legend 
File name display for an added trace, selection of a displayed trace, 
and selection of a trace to be added/deleted can be executed. 
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(3) FFT graph display area 
An FFT graph is displayed in this area. Cursor move and graph 
zoom-in display can be executed. 

(4) Add/Delete (trace addition/deletion) 
A trace can be added/deleted. 

(5) FFT Points 
The number of points of the X axis in the FFT graph display area 
can be specified. 

(6) Cursor Position 
The cursor position in the FFT graph display area can be specified 
by entering a value in the Frequency text box. 

(7) Quick Add Mode (interaction with signal generation application) 
Settings for addition of a waveform pattern generated by a signal 
generation application to the FFT graph display in conjunction with 
the signal generation application can be executed. 

(8) Scale setting 
The scale of the X and Y axes in the FFT graph display area can be 
changed. 

(9) Mouse Interaction 
The mouse operation in the FFT graph display area can be set to 
either the cursor move function or the zoom-in function. 
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4.4.3 Displaying FFT graph 
A waveform pattern generated by a signal generation application of the 
IQproducerTM can be read and displayed in an FFT graph. 

 FFT graph display 

<Procedure> 

1. Click one of the option buttons in the Legend dialog box to select the 
trace color of the wave form pattern in the FFT graphical area.  

 

Figure 4.4.3-1  Selecting radio button in Legend 

 

2. Click the FFT Points button to display the FFT Points dialog box. 
Then, select the number of points for the FFT operation. Be sure to 
select a value smaller than the number of sample points of the 
selected waveform pattern. 

 

Figure 4.4.3-2  FFT Point selection 
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3. Click the Add button. 

The Add button is disabled when any other waveform pattern is 
already specified on the selected option button. In such a case, delete 
the waveform pattern by clicking the Delete button, or click one of 
other option button.  

 

Figure 4.4.3-3  Add button 

 

Otherwise, click Add Trace from the File menu. 

 

Figure 4.4.3-4  Add Trace in File menu 

 

4. Click the  button in the Add Trace screen, and select a 
waveform pattern for which an FFT graph is displayed. 

 

 

Figure 4.4.3-5  Add Trace screen 
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5. Click the OK button on the Add Trace screen to read the waveform 
pattern. A graph calculation progress screen as shown below is 
displayed while reading the waveform pattern. 
When the graph calculation has completed, the FFT graph display 
screen is displayed again with a trace in the color selected in the 
Legend field. 
If a waveform pattern having a different sampling rate with that of 
the currently displayed waveform pattern is added, the current 
waveform pattern display disappears. 
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4.4.4 Deleting FFT graph 
The FFT graph displayed in the screen can be deleted. 

 Deleting FFT graph display 

<Procedure> 

1. In the Legend field, click the radio button of the trace to be deleted. 

 

Figure 4.4.4-1  Selecting radio button in Legend 

 

2. Click the Delete button to delete the graph corresponding to the 
selection in the Legend field.  

 

Figure 4.4.4-2  Delete button 

 

 Otherwise, click Delete Trace from the File menu. 

 

Figure 4.4.4-3  Delete Trace in File menu 

 

 The trace selected in Legend is deleted. After deleting a trace, 
another waveform pattern can be selected for that item.  
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4.4.5 Changing graph display area and axis plot interval 
The plot interval of the X axis (frequency) on the FFT graph and the data 
range for FFT analysis can be changed. 

 

 

Figure 4.4.5-1  Parameter input 

 

<Procedure> 

1. Click the FFT Points button to display the FFT Points dialog box. 
Then, select the number of points for the FFT operation.  

When the focus is moved to another control after selecting the FFT 
Points value, the plot interval of the X axis in the graph display area 
is changed.  

2. Click the Sampling Range text box and enter the Sampling Range 
value.  
When the focus is moved to another control after changing the 
Sampling Range value, the data range of the waveform pattern for 
FFT analysis is changed.  

When the FFT Points value is changed, the new FFT Points value is 
applied to all the waveform patterns currently read. If the Sampling 
Range value has been set before changing the FFT Points value, it is 
cleared to “0”  “FFT Points  1” after FFT Point value changes. 
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4.4.6 Interaction with signal generation application (Quick Add Mode) 
The method for updating the FFT graph display in conjunction with 
waveform pattern generation by a signal generation application can be 
set and changed. This function is enabled only when the FFT graph 
display function is activated. Click the Quick Add Mode button to display 
the Quick Add Mode dialog box.  

 

Figure 4.4.6-1  Quick Add Mode 

 

 When Add is selected: 

A trace is added to the FFT graph when FFT is selected from the 
Simulation menu or the FFT tool button is clicked after data generation 
by the signal generation application. Note that the FFT graph display 
will not be updated when the four traces are all used. 
 
 When Clear is selected: 

A trace is deleted from the FFT graph and the FFT analysis result of the 
generated data is displayed when FFT is selected from the Simulation 
menu or the FFT tool button is clicked after data generation by the signal 
generation application. 
 
 When Off is selected: 

The FFT graph display will not be updated even when FFT is selected 
from the Simulation menu or the FFT tool button is clicked after data 
generation by the signal generation application. 
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4.4.7 Selecting mouse interaction in CCDF graph display area 
Cursor move or graph zoom-in is selected for a mouse dragging operation 
in the FFT graph display area. Click the Mouse Interaction button to 
display the Mouse Interaction dialog box.  

Cursor The mouse is used to move the cursor.  

Zoom The mouse is used to set the zooming area.  

 

Figure 4.4.7-1  Mouse Interaction Dialog Box 
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4.4.8 Moving graph cursor 
The cursor displayed in the FFT graph display area can be moved. 

 Moving cursor using mouse 

The black-line cursor moves by dragging the cursor in the FFT graph 
display area. 

 

 

Figure 4.4.8-1  Cursor in FFT graph display area 

 

The contents displayed in Cursor in the FFT graph display screen are 
updated as the cursor is moved. 
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 Moving cursor changing Cursor value 

The black-line cursor is moved by changing the value of Cursor in the 
FFT graph display screen. 

 

Figure 4.4.8-2  Cursor input 

 

Click the Frequency text field and enter the Frequency value from the 
keyboard. 

When the focus is moved after changing the Frequency value, the 
black-line cursor in the FFT graph display area is moved. 
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4.4.9 Changing graph scale 
The scale of the graph currently displayed can be changed. 

 Changing graph display area scale 

The scales for the X and Y axes in the FFT graph display area are 
updated by changing the value in Scale in the FFT graph display screen. 

 

Figure 4.4.9-1  Scale input 

 

<Procedure> 

1. Click the Frequency text field and enter the Frequency value. 

2. Click the Amplitude text field and enter the Amplitude value. 

3. When the Full Scale button is clicked, the scales for both axes are 
adjusted so that the entire of FFT graph is displayed. 
 

When the focus is moved after changing the value in the Frequency text 
box as shown in 1. above, the scale for the X axis in the FFT graph 
display area is updated. 

Similarly, when the focus is moved after changing the value in the 
Amplitude text box as shown in 2. above, the scale for the Y axis in the 
FFT graph display area is updated. 
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Figure 4.4.9-2  Graph scale change in FFT graph display area 

 

 Specifying display area by mouse operation 

When Zoom is selected for Mouse Interaction, pointing and dragging an 
area in the CCDF graph enlarges the selected area (enclosed by dotted 
lines). 
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4.4.10 Printing/saving graph data 
 Printing out graph display screen 

Click Print Window Image from the File menu to display the print screen. 
Set the printer, printing range, number of copies, etc., in this screen, and 
print out the FFT graph display screen (entire of the window) from the 
printer. 

 

Figure 4.4.10-1  Print Window Image in File menu 

 

 Outputting graph data to file 

Click Export Data from the File menu to display the file save screen. Set 
the saving destination, etc., in this screen, and click the Save button. 
Lists of Peak per Average (dB) and Probability (%) are saved to a file in 
the CSV format (a text file format in which values are delimited by a 
comma). 

 

Figure 4.4.10-2  Export Data in File menu 

 

 Copying graph image on screen 

Click Copy Graph Image from the Edit menu to copy the current graph 
image on the screen to the clipboard. 

 

Figure 4.4.10-3  Copy Graph Image in Edit menu 
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4.5 File Conversion on Convert Screen 
ASCII-format waveform patterns generated by simulator software, 
digitized files created by the MS2690A/MS2691A/MS2692A or 
MS2830A/MS2840A using the digitize function, and waveform patterns 
formatted for the MG3700A/MG3710A/MG3740A can be converted into a 
file in the format that can be used in the MS2690A/MS2691A/MS2692A 
or MS2830A/MS2840A. Conversely, a waveform pattern for the 
MS269x/MS2830/MS2840 can also be converted into a file that can be 
used in the MG3700A/MG3710A/MG3740A. The output file consists of a 
waveform information file (text format file with the extension “.wvi”) that 
stores the information related to the waveform pattern and a waveform 
data file (binary format file with the extension “.wvd”).  

If the Convert screen is displayed in the MS2830/MS2840 mode, the 
functions below can be used.  

Whether the memory option is used can be selected.  

When With option 27(Memory 256Msamples) is selected for Memory 
Option, the maximum size of waveform patterns that can be generated 
increases from 64Msamples to 256Msamples. Enabling the memory 
option increases the maximum size of waveform patterns, but waveform 
patterns exceeding 64 Msamples can only be used if the ARB memory 
expansion option 256Msamples is installed for the used option 
(MS2690A/MS2691A/MS2692A, MS2830A, or MS2840A ). Change the 
setting according to whether the ARB memory expansion option 
256Msamples is installed for the used option 
(MS2690A/MS2691A/MS2692A, MS2830A, or MS2840A).  
The waveform pattern bit width can be selected as 14, 15, or 16 bits.  
Changing the bit width can improve the dynamic range. In addition, the 
specifiable RMS value range and usable marker signals differ for each bit 
width as follows.  
 

Table 4.5-1 Restrictions on each bit width 

Bit 
Width 

Specifiable RMS Value 
Range 

Usable Marker  
Signals 

14 bit 1 to 8191 Marker 1 to 3, RF Gate 

15 bit 1 to 16383 Marker 1, RF Gate 

16 bit 1 to 32767 None 

 
The specifiable bit widths differ for each conversion file format as follows.  
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Table 4.5-2 Input file format and specifiable bit widths 

Input File Format Selectable Bit Width

ASCII1 14/15/16 bit 

ASCII2 16 bit 

ASCII3 14/15 

MS269x/MS2830/MS2840 Digitizer 14/15/16 bit 

MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700) 14 bit 

MG3700/MS269x/MS2830/MS2840 (to MG3710) 14 bit 

MG3700/MS269x/MS2830/MS2840 (to MG3740) 14 bit 

MG3700/MG3710/MG3740/MS2830/MS2840 (to MS269x) 14 bit 

MG3700/MG3710/MG3740/MS269x (to MS2830/MS2840) 14 bit 

 

4.5.1 Activation 
Click the Convert button on the General Purpose tabbed box in the 
Common Platform Screen. The Convert screen is displayed separately.  
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4.5.2 Convert screen 

            Input file selection

File data sett ing

File format

Comment entry

Burst data sett ing

Data conversion

Exit

RF Gate sett ing

Time Domain

 

Figure 4.5.2-1  Convert screen 

 

 Description of items 

(1) Input file selection 
Click the Reference button and select a file to be input. 
Two or more files can be selected. The selected files are displayed in 
the left field. The number of files to be selected varies depending on 
the file format setting. 

(2) File data setting 
Set the data to be written in the waveform information file (.wvi 
format) of the waveform pattern to be generated. 

(3) File format 
Select a file format of the conversion source file from: 

ASCII1,ASCII2,ASCII3, 
MS269x/MS2830/MS2840 Digitizer, 
MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700), 
MG3700/MS269x/MS2830/MS2840 (to MG3710), 
MG3700/MS269x/MS2830/MS2840 (to MG3740), 
MG3700/MG3710/MG3740/MS2830/MS2840 (to MS269x), 
MG3700/MG3710/MG3740/MS269x (to MS2830/MS2840) 

(4) Comment entry 
Enter the comment. 
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(5) Burst data setting 
Set the Burst data. The Burst data includes Gap Length and Frame 
Length, and they should be set respectively.  
For a non-Burst continuous wave, set the number of samples per 
frame of the used communication system or “1” for Frame Length, 
and set “0” for Gap Length. 
When an external trigger is used, the waveform pattern output 
timing is determined based on this setting. Refer to 2.6.2 “Setting 
Start/Frame trigger” in the Vector Signal Generator Operation 
Manual (Operation) for details of the external trigger. 

(6) RF Gate setting (ASCII file and digitized file conversion) 
Configures the RF gate settings. These parameters are enabled only 
when the file format is set to ASCII1, ASCII2, ASCII3, or 
MS269x/MS2830A/MS2840 Digitizer. When the RF Gate check box is 
selected, RF Gate processing is performed during waveform pattern 
conversion for samples in which the I and Q values ( jQI  ) of the 
input ASCII file or digitized file data are continuously at or below 
the threshold level. The threshold level can be set by entering a ratio 
to the waveform pattern peak value in the RF On/Off Threshold text 
box. The RF Gate is executed only for the samples in which the I and 
Q values less than the threshold level continue for longer than the 
value set in the Minimum RF Gate Length text box. Since the 
samples for which the RF Gate is executed are excluded for rms 
calculation during waveform pattern conversion, it is therefore 
possible to prevent underestimation of the rms value of the burst 
signal waveform pattern (accordingly, the output level in a burst-on 
interval can be kept under the specified RF output level). 

(7) Data conversion 
Starts file conversion. 

(8) Exit 
Ends the conversion process. 
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4.5.3 Selecting input file 
Select a file to be converted. 

<Procedure> 

1. Click the  button in the File format box to open a pull-down 
menu, and select the format of the file to be input. 

2. Click the Reference button to open the file dialog box, and select a 
file to be converted (conversion source file). 
The file selection dialog box is displayed when selecting several files 
having the same file format. Select a data file displayed in the file 
type. 

 

Figure 4.5.3-1  Conversion source file selection 

 

 The number of files to be selected and the file type differ depending 
on the file format as follow: 

ASCII1: One file that contains I-phase data, Q-phase data, and 
marker data. 

ASCII2: Two files of I-phase data file and Q-phase data file. 

ASCII3: Three files of I-phase data file, Q-phase data file, and 
marker data file. 

MS269x/MS2830/MS2840 Digitizer:  
xml file, which is a digitized file created by the Signal 
Analyzer using the digitize function.  

MG3710/MG3740/MS269x/MS2830/MS2840 (to MG3700): 
Of the wvi and wvd files, which are waveform patterns for 
the MG3710A, MG3740A, MS269x, MS2830A or MS2840A, 
respectively, select the wvi file. 

MG3700/MS269x/MS2830/MS2840 (to MG3710): 
Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MS269x, MS2830A or MS2840A, 
respectively, select the wvi file. 

MG3700/MS269x/MS2830/MS2840 (to MG3740): 
Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MS269x, MS2830A or MS2840A, 
respectively, select the wvi file. 

MG3700/MG3710/MG3740/MS2830/MS2840 (to MS269x): 
Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MG3710A, MG3740A, MS2830A or 
MS2840A, respectively, select the wvi file.  
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MG3700/MG3710/MG3740/MS269A (to MS2830/MS2840): 
Of the wvi and wvd files, which are waveform patterns for 
the MG3700A, MG3710A, MG3740A and MS269A, 
respectively, select the wvi file.  

 Click the OK button to finalize the input file selection.  
Click the Cancel button to cancel the input file selection. 

 If the file format is changed in the File format box after selecting the 
input files, the current settings are cleared.  

3. In the MS2830A/MS2840A mode, the dialog box below for selecting 
the bit width appears after selecting the input file. Specify 14, 15, or 
16 bits. However, the bit widths that can be specified depend on the 
selected file format as shown in Table 4.5-2.  

 

Figure 4.5.3-2 Bit-width specification dialog box 

 

4. When the input files are selected, they are read and a dialog box 
appears displaying the maximum value, minimum value, RMS value 
and the number of data.  
In this dialog box, the edit boxes for setting the first and last 
samples are displayed only when MS269x/MS2830A/MS2840A 
Digitizer is selected for the file format. Use the edit boxes for setting 
the reading range. 
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Figure 4.5.3-3  Input file information display dialog box 

 

 Click the OK button to finalize the input file selection. 
Click the Cancel button to cancel the input file selection. 

 If the file format is changed in the File format box after selecting the 
input files, the current settings are cleared. 

 

4.5.4 Editing data in Convert screen 
The data to be written in the waveform information file of the waveform 
pattern to be generated can be edited by setting the parameters in the 
Waveform Pattern parameters field. 

 Setting sampling rate 

<Procedure> 

1. Click the Sampling Rate box and enter a sampling rate value to be 
set to the Vector Signal Generator from the keyboard. 
After the waveform pattern is selected by the Vector Signal 
Generator, the sampling rate can be changed to any value within the 
setting range when the selected waveform pattern is actually used. 
The sampling rate can be set from 20 kHz to 160 MHz. 

2. Click the  button on the right of the Sampling Rate box to open a 
pull-down menu, and select the unit of the sampling rate. 
The unit can be set from Hz, kHz, and MHz. 
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Figure 4.5.4-1  Sampling Rate input 

 

 Normalizing setting (only available when the Convert screen is displayed 

in the MS2830A/MS2840A mode) 

To apply the RMS (Route Mean Square) value of the standard waveform 
pattern used by the MS2830A or MS2840A to the amplitude of the 
waveform pattern to be converted, select the Normalizing check box.  

 

Figure 4.5.4-2 Normalizing selection 

 

Here, the RMS (Root Mean Square) value of the standard waveform 
pattern used for the MS2830A or MS2840A refers to the RMSI and RMSQ 
values below. However, these values depend on the specified bit width.  

 
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RMS )(
1 22


n

nI I
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
n
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N
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Here, Σ  indicates the sum of target waveform patterns. (except 

samples for which RF Gate is used to set RF output to Off).  
 

 

Table 4.5.4-1 Bit widths and RMS values for standard waveform 

patterns 

Bit Width RMSI RMSQ RMSIQ 

14bit 1157 1157 1636 
15bit 2314 2314 3272 
16bit 4628 4628 6545 

 

RMSI indicates the RMS value for the I phase, and RMSQ indicates that 
for the Q phase.  
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RMSIQ indicates the RMS value of the I/Q vector when RMSI and RMSQ 
are as described above.  

When Normalization is selected, a crest factor (Peak Power/RMS Power) 
of 17 dB can be obtained if the signal output of the MS2830A or 
MS2840A is set within the level assurance range.  

 RMS Value and Peak Value setting 

When the Convert screen is displayed in the MS269xA mode 

The RMS value and the Peak value are displayed in each text box. The 
RMS value is fixed to 1157. The Peak value calculation method varies 
depending on the read file type. When an ASCII1, ASCII2, ASCII3, or a 
digitized file of the MS2690A/MS2691A/MS2692A, MS2830A, or 
MS2840A is read, the value is calculated from the RMS value (1157) and 
the ratio of the peak value calculated at file reading to the average (peak 
/ average), and is displayed. When a waveform pattern for the MG3700A 
or a waveform pattern for the MS2690A/MS2691A/MS2692A, MS2830A, 
or MS2840A is read, the ratio of the Peak to the average (peak / average) 
is obtained from the value recorded in the wvi file, and the value is 
calculated from the obtained value.  
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When the Convert screen is displayed in the MS2830A/MS2840A mode 

When reading waveform patterns, the data in the file to be converted is 
read, and then the RMS and Peak values are calculated and displayed. 
Click the RMS Value text box, and then enter the RMS value of the 
post-conversion waveform that is actually used for the MS2830A or 
MS2840A. The Peak value changes according the specified RMS value. 
Similarly, if the Peak Value text box is clicked and the Peak value is 
specified, the RMS value changes.  

 

Figure 4.5.4-3 RMS Value input 

 

Normally, the Normalizing check box is selected and the RMS and Peak 
values are automatically specified, but the values can be manually 
specified to adjust the characteristics for such signals that have a crest 
factor larger than 17 dB.  

Note that the RF output level reliability for the MS2830A or MS2840A is 
specified assuming the following RMS values.  

Table 4.5.4-2 RMS-value setting ranges that guarantee output level 

reliability 

Bit Width RMS-value setting range 

14 bit 819 to 1634 
15 bit 1638 to 3269 
16 bit 3276 to 6537 
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 Memory size setting (only available when the Convert screen is displayed 

in the MS2830A/MS2840A mode) 

Select whether the ARB memory expansion option 256Msamples is 
installed for the used option (MS2830A or MS2840A). Specifying With 
Option 27(Memory 256Msamples) increases the maximum size of 
waveform patterns that can be generated, but waveform patterns 
exceeding 64Msamples can only be used if the ARB memory expansion 
option 256Msamples is installed for the used option (MS2830A or 
MS2840A). Change the setting according to whether the ARB memory 
expansion option 256Msamples is installed for the used option (MS2830A 
or MS2840A).  

 

Figure 4.5.4-4 Memory Option selection 

 Setting package name 

Enter the name of the package that is used to store the generated 
waveform patterns when transferring them to the Vector Signal 
Generator option. 
Up to 31 characters can be used for a package name. 
Alphanumeric characters and the following symbols may be used: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 

Figure 4.5.4-5  Package input 

 

 Unit setting (only available when ASCII1, ASCII2, ASCII3, or 
MS269x/MS2830A/MS2840A Digitizer is specified) 

Click  in the Unit symbol list box, and then select the unit.  
sample, symbol, chip, or none can be selected as the unit.  
This setting is used as the unit for displaying values on screens when 
using waveform patterns with the MS2690A/MS2691A/MS2692A, 
MS2830A, or MS2840A.  

 

Figure 4.5.4-6 Unit symbol selection 
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 Selecting spectrum (available for ASCII1, ASCII2, ASCII3, and Digitizer) 

Click the  button on the right of the Spectrum box to open a 
pull-down menu, and select the spectrum from Normal and Reverse. 
When Reverse is selected, the phase of the RF modulated signal output is 
reversed. 

 

Figure 4.5.4-7  Spectrum selection 

 

 Setting over sampling rate (available for ASCII1, ASCII2, ASCII3, and 

Digitizer) 

Set the over sampling rate for the waveform pattern to be input to 
Convert. Click the Over Sampling box and enter a numeric value from 
the keyboard.  

When setting the sampling rate of 4 MHz for signals with 1-MHz symbol 
rate, for example, enter “4”.  

  

Figure 4.5.4-8  Over Sampling input 

 

 Setting Data Points (available for ASCII1, ASCII2, and ASCII3) 

The number of sample points of the read waveform pattern is displayed 
in the Data Points box. Enter a Data Points value from the keyboard to 
change the value, though it is not necessary to change this setting 
normally. 

 

Figure 4.5.4-9  Data Points input 

 

The maximum number of Data Points is 256M points. The number of 
sample points of the read data is greater than 256M points, an error 
message is displayed and reading fails. 
When the number of sample points of the read waveform is less than 
1000 points, the output pattern is repeated so that the number of output 
patterns becomes 1000 points or more. When the number of sample 
points of the read waveform is 99 points, for example, the output pattern 
is repeated 11 times and a waveform pattern with 1089 points is output. 
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 Entering comments 

Click the Comment Line 1 box and enter a comment from the keyboard. 
The text entered here is displayed on the screen when the Vector Signal 
Generator option selects the corresponding waveform. 
Leave this text box blank if unnecessary. 
The Comment Line 2 box is disabled until any comment is entered in the 
Comment Line 1 box. Similarly, the Comment Line 3 box is disabled 
until any comment is entered in the Comment Line 2 box. 

 

Figure 4.5.4-10  Comment Line input 

 Setting marker names 

To set a marker name, select the Marker Name check box. Then the 
Marker 1 Name, Marker 2 Name, and Marker 3 Name boxes become 
available. Click an input area and enter a marker name. 
Note that these settings do not enable/disable the marker output of the 
Vector Signal Generator option. 
The contents of these settings are displayed on the Vector Signal 
Generator option screen. 

 

Figure 4.5.4-11  Marker Name input 

 

 Setting Burst information 

To set the Burst information, select the Burst Setting check box. Then 
the Frame Length and Gap Length boxes become available. Click an 
input area and enter a numeric value to set Frame Length and/or Gap 
Length. 
Refer to Section 5.1 “Generating Waveform Pattern” for details. 

 

Figure 4.5.4-12  Burst Setting input 
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 Configuring RF Gate settings (ASCII file and for digitized file conversion) 

To configure the RF Gate settings, select the RF Gate check box. The RF 

On/Off Threshold and Minimum RF Gate Length boxes will then become 
available. Click an input area and enter a numeric value to set the RF 
On/Off threshold and minimum RF gate length. 

 

Figure 4.5.4-13  RF Gate setting input 
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4.5.5 Executing conversion 
Set a file before conversion (conversion source file) and a file after 
conversion (conversion destination file) before executing conversion. 

<Procedure> 

1. Click the Convert button to display the Export File screen shown in 
Figure 4.5.5-2 below. 

 

Figure 4.5.5-1  Convert button 

 

2. Click the Export File Name box on the Export File screen and enter 
the name of the file to be output. 

 

 

Figure 4.5.5-2  Export File screen 
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3. Click the OK button to start conversion. 
After this, if a clipping occurs during the conversion, the warning 
message “The waveform pattern to be generated will be above 8191 
and be clipped.” is displayed. If the OK button on the warning 
message dialog box is clicked at this time to continue the conversion 
as is, a waveform pattern for which clipping has been processed is 
generated. 

 

Figure 4.5.5-3  Conversion executing screen 

 

 The Conversion executing screen is displayed from the start to the 
end of conversion. 

4. When conversion is completed, click the OK button to return to the 
Convert screen. 

 Two files of a file with the extension “.wvi” and a file with the 
extension “.wvd” are output and created in the file specified by the 
Export Path box after conversion. 
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4.5.6 Input file format 
There are the following eight types of acceptable file for the Convert 
operation.  

 ASCII1 format file  

 ASCII2 format file  

 ASCII3 format file  

 The digitized file generated by the MS269x Digitizer (The digitizing 
capability of MS2690A/MS2691A/MS2692A, MS2830A or MS2840A 
signal analyzer)  

 The waveform pattern formatted for MG3710A, MG3740A, MS269xA, 
MS2830A or MS2840A (MG3710/MG3740/MS269x/MS2830/MS2840 
(to MG3700)) 

 The waveform pattern formatted for MG3700A, MS269xA, MS2830A 
or MS2840A (MG3700/MS269x/MS2830/MS2840 (to MG3710)) 

 The waveform pattern formatted for MG3700A, MS269xA, MS2830A 
or MS2840A (MG3700/MS269x/MS2830/MS2840 (to MG3740)) 

 The waveform pattern formatted for MG3700A, MG3710A, MG3740A, 
MS2830A or MS2840A (MG3710/MG3740/MG3700/MS2830/MS2840 
(to MS269x)) 

 The waveform pattern formatted for MG3700A, MG3710A, MG3740A 
or MS269xA (MG3710/MG3740/MG3700/MS269x (to 
MS2830/MS2840)) 

This section describes the ASCII-format files.  

ASCII format files contain the following data: 

 I-phase data 

This is in-phase component data of the waveform pattern 
 

 Q-phase data 

This is quadrature-phase component data of the waveform pattern 
 

 Marker data 

This data is used to output marker signals from the AUX connector on 
the rear panel. There are three types of signal outputs: Marker 1, Marker 
2, and Marker 3. 
Each signal of marker data outputs either of the following TTL values: 
0 = LO level 
1 = HI level 
 

When the Vector Signal Generator option uses waveform patterns, the 
difference between the marker data output timing and the timing the 
Vector Signal Generator option outputs the modulation data 
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corresponding to the output marker data from the RF Output connector 
is adjusted to be within approx. 1 sample. 
 

 

Figure 4.5.6-1  MS269xA AUX Connector On Rear Panel 

 

 

 

Figure 4.5.6-2  MS2830A/MS2840A AUX Connector On Rear Panel 
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Marker data output Data2Data1

RF output

Data3 Data4

I/Q1 I/Q2 I/Q3 I/Q4

1 sample
 

Figure 4.5.6-3  Marker data output and RF output 

 
 RF Gate 

This data is used to execute pulse modulation for the RF output when 
using a Burst wave such as TDMA. 
Each signal of RF Gate data indicates as follows: 
0 = RF signal output On 
1 = RF signal output Off 
 

The RF Gate data is adjusted by the internal delay circuit of the Vector 
Signal Generator option so as to be input to the internal pulse modulator 
of the Vector Signal Generator option at almost the same time when the 
IQ-phase data corresponding to the RF Gate data is input to the pulse 
modulator. The pulse modulation timing for the RF output can be 
adjusted, therefore, by applying RF Gate = 0 at the same position with 
the IQ-phase data where the RF signal is required to be Off. 
When the data for both the I and Q phases are set to 0000h and the RF 
output is set to Off instead of using this bit (i.e., RF Gate data = 1), the 
On/Off power ratio of the RF output signal becomes smaller than that in 
the case using the RF Gate data. Therefore, when a larger On/Off power 
ratio is required, set the data for both the I and Q phases to 0 and then 
set the RF output to Off using the RF Gate data. Note that the sample 
for which RF output is set to Off using the RF Gate data is excluded from 
RMS value calculation/adjustment when reading input file or generating 
waveform pattern file. Refer to Section 4.5.4 “Editing data in Convert 
screen” for details. 
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Waveform

memory

DA converter

14

14
Vector

modulator

Pulse

modulator

3

Markers 1, 2, 3

RF Gate

Delay
3

Waveform data Sample 2Sample 1

RF Gate

Sample 3 Sample 4

1 0 1 0

RF output ON OFF ON ON

Waveform data, 14 bits  2 ch

 

Figure 4.5.6-4  Configuration of waveform pattern output part in  

Vector Signal Generator option and signal output timing 

 

The following describes details of the ASCII1, ASCII2, and ASCII3 
formats: 

 ASCII1 

Waveform patterns before conversion are configured in one file.  
One line indicates one data. The data format is delimited by a comma, in 
the order of I-phase data, Q-phase data, Marker 1, Marker 2, Marker 3, 
and RF Gate.  
 

I-phase 
data 

Q-phase 
data 

Marker1 Marker2 Marker3 
RF 

Gate 

Figure 4.5.6-5 ASCII1 data format   

 

The values for Markers 1 to 3 and RF Gate can be omitted. If these 
values are omitted, Markers 1 to 3 are assumed to be 0 (low level) and 
RF Gate is assumed to be 1 (indicating that RF output is On). However, if 
the Convert screen is displayed in the MS2830A/MS2840A mode, the 
format for Markers 1 to 3 and RF Gate depends on whether the 15 or 
16-bit data width is specified as described below.  
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When 15 bit is specified 

The data format is delimited by a comma, in the order of I-phase data, 
Q-phase data, Marker 1, Marker 2, Marker 3, and RF Gate.  

I-phase data Q-phase data Marker1 RF Gate 

Figure 4.5.6-6 ASCII1 data format (when 15 bit is specified)              

 

If the values for Marker 1 and RF Gate are omitted, they are assumed to 
be 0 and 1, respectively. In addition, if data is specified as shown in 
Figure 4.5.6-5, only the Marker 1 and RF Gate values are read. If the RF 
Gate value is omitted, it is automatically set to 1.  

When 16 bit is specified 

As shown in Figure 4.5.6-7, the data format consists of I-phase data 
followed by Q-phase data, and the values are delimited with a comma. 
Markers 1 to 3 are automatically set to 0, and RF Gate is automatically 
set to 1.  

I-phase 
data 

Q-phase 
data 

Figure 4.5.6-7 ASCII1 data format (when 16 bit is specified)  

 

In addition, if the information for Markers 1 to 3 and RF Gate is specified 
as shown in Figure 4.5.6-5, the information is ignored, Markers 1 to 3 are 
automatically set to 0, and RF Gate is automatically set to 1.  

If the RF Gate check box is selected, RF Gate is automatically set 
according to the parameters specified for RF On/Off Threshold and 
Minimum RF Gate Length. However, if the Convert screen is displayed in 
the MS2830A/MS2840A mode and the 16-bit bit width is specified, it is 
not possible to select the RF Gate check box.  
Set ‘0’ or ‘1’ for Markers 1 through 3 and RF Gate. Markers 1 through 3 
and RF Gate can also be omitted. If omitted, ‘0 (LO level)’ is applied to 
Markers 1 through 3 and ‘1 (RF Output On)’ to RF Gate. 
A line starts with a character other than numeric, ‘+’, or ‘’ is regarded as 
a comment line, and is ignored. I-phase data and Q-phase data can be 
expressed decimally, and also in exponents using e or E like “2.0E+3”. 
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// IQ Data 
Comment Line 
0.214178,0.984242 
0.187286,1.245890 
0.073896,1.368888 
0.091758,1.316199 
0.073896,1.368888,1 # Marker1 = 1 is output. 
0.091758,1.316199,0,1 # Marker2 = 1 is output. 
0.248275,1.089333,0,0,1 # Marker3 = 1 is output. 
0.331432,0.729580,0,0,0,0 # RF output becomes Off. 
0.331432,0.729580,,0,0,1 # Marker1 = 0 is output and RF output 

becomes On. 
… 
 
// IQ Data (when the Convert screen is displayed in the 
MS2830A/MS2840A mode and the 15-bit bit width is specified) 
Comment Line 

0.214178, 0.984242 

0.187286, 1.245890 

0.073896, 1.368888 
0.091758, 1.316199 

0.073896, 1.368888,1  
# Marker1 = 1 is output and RF output becomes On.  

0.091758, 1.316199,0,1  
# Marker1 = 0 is output and RF output becomes On.  

0.248275, 1.089333,,0  
# Marker1 = 0 is output and RF output becomes Off.  

0.331432, 0.729580,1,0,0  
# Marker1 = 1 is output and RF output becomes On.  

0.331432, 0.729580,1,0,0,1  
# Marker1 = 1 is output and RF output becomes On.  
… 

// IQ Data (when the Convert screen is displayed in the 
MS2830A/MS2840A mode and the 16-bit bit width is specified) 
Comment Line 

0.214178, 0.984242 

0.187286, 1.245890 

0.073896, 1.368888 
0.091758, 1.316199,1,1,1,0  

# Marker1 to 3 = 0 is output and RF output becomes On.  
… 
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 ASCII2 

I-phase data is stored in one file, Q-phase data is stored in another, and 
the Marker data file for the ASCII3 format described below is excluded. 
When using this format, Markers 1 to 3 are set to 0, RF Gate is set to 1, 
and Marker output is all 0s. If the RF Gate check box is selected for this 
format, RF Gate is automatically set according to the parameters 
specified for RF On/Off Threshold and Minimum RF Gate Length. 
However, if the Convert screen is displayed in the MS2830A/MS2840A 
mode and the 16-bit bit width is specified, it is not possible to select the 
RF Gate check box. If the RF Gate check box is not selected, RF output is 
On for all waveform pattern samples. In addition to displaying I-phase 
data and Q-phase data using decimal values, such data can be displayed 
using e or E and exponential notation (such as “2.0E+3”).  

 ASCII3 

For this format, pre-conversion waveform patterns are stored in three 
files. The patterns are divided such that I-phase data is stored in the 
first file, Q-phase data in the second, and Marker 1 to 3 and RF Gate 
data in the third. The Marker 1 to 3 and RF Gate data is stored in the 
following order, delimited by commas: Marker 1, Marker 2, Marker 3, 
and then RF Gate. Markers 1 to 3 can only be set to 0 and RF Gate can 
only be set to 1. The values for Markers 1 to 3 and RF Gate can be 
omitted. If these values are omitted, Markers 1 to 3 are assumed to be 0, 
and RF Gate is assumed to be 1. However, if the Convert screen is 
displayed in the MS2830A/MS2840A mode and the 15-bit bit width is 
specified, the format for Marker 1 to 3 and RF Gate data differs from the 
above.  
Because only Marker 1 and RF Gate are used when the 15-bit bit width 
is specified, the data consists only of the Marker 1 data followed by the 
RF Gate data, with the values delimited by a comma. If these values are 
omitted, Marker 1 is assumed to be 0 and RF Gate is assumed to be 1. If 
data for Markers 1 to 3 and RF Gate (a total of four data items) is 
specified, the Marker 2 and Marker 3 data is ignored, and only the 
Marker 1 and RF Gate data is read. If the RF Gate value is omitted, it is 
assumed to be 1.  
If the RF Gate check box is selected, RF Gate is automatically set 
according to the parameters specified for RF On/Off Threshold and 
Minimum RF Gate Length.  
In each file, the I-phase data, Q-phase data, and Markers 1 through 3 
and RF Gate data are combined and described in one line delimited by 
<cr><lf> with the same line number. Therefore, when a comment line is 
added to the start of one of these files, it is necessary to adjust the 
number of lines among the files by adding a comment line or <cr><lf> to 
other files. An error occurs if the number of lines differs between the 
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I-phase data and Q-phase data. If Markers 1 through 3 and RF Gate data 
exists in a line where I-phase and Q-phase data do not exist, it is 
regarded that line has no data. If the data line of a different file is 
described in a comment line in a certain file, that data line is ignored. 
A line starts with a character other than numeric, ‘+’, or ‘–’ is regarded as 
a comment line, and is ignored. I-phase data and Q-phase data can be 
expressed decimally, and also in exponents using e or E like “2.0E+3”. 

File 1 (I-phase data) 

// I Data 
Comment Line 

0.214178 

0.187286 

0.073896 
0.091758 
0.248275 
0.331432 
… 
 

File 2 (Q-phase data) 

// Q Data 
<cr><lf> # Adjusting the line number since two comment lines  

0.984242 are added in the I-phase data. 

1.245890 

1.368888 

1.316199 

1.089333 

0.729580 
… 
 

File 3 (Marker data) 

<cr><lf> 
<cr><lf> 
<cr><lf> # Markers 1through 3 = 0 and RF Gate = 1 for the 
<cr><lf> third and fourth lines. 
1 # Corresponds to the fifth line data in the I-phase  
0,1 and Q-phase data. 
0,0,1 
1,0,0,1 
… 
When the Convert screen is displayed in the MS2830A/MS2840A mode 
and the 15-bit bit width is specified  
<cr><lf> 
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<cr><lf> 
<cr><lf> Lines 3 and 4 are Marker = 0 and RF Gate = 1, 

respectively.  
<cr><lf> 
1  # Corresponds to the fifth line data in the I-phase and 
Q-phase data.  
0,0  # Marker1 = 0 is output and RF output becomes On.  
1,0,0  # Marker1 = 1 is output and RF output becomes On.  
1,1,1,0 # Marker1 = 1 is output and RF output becomes 0.  
… 
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4.5.7 Setting the RMS-value calculation range 
By displaying the Time Domain screen from the Convert screen, the 
pre-conversion waveform pattern can be checked, the RMS-value 
calculation range can be set, and the RMS value of the read waveform 
can be recalculated.  
However, the Time Domain screen can only be displayed if the file format 
is set to ASCII1, ASCII2, ASCII3, or MS269x/MS2830A/MS2840A 
Digitizer.  

To display the Time Domain screen, click the Time Domain button.  

 

Figure 4.5.7-1 Time Domain screen displaying button 

 

For details about using the Time Domain screen to specify the 
RMS-value calculation range, see Section 4.9.13 “Displaying the Time 
Domain screen from the Convert screen”.  

When the RMS-value calculation range is set, the RMS value for the 
waveform pattern is recalculated, and the value in the Peak Value text 
box is updated.  
Using the above function makes it possible to prevent the ratio between 
the Peak value of a wave for which RF Gate is not set and the RMS value 
from being reduced as well as the resulting clipping.  

time

Power

Range set in Time Domain 

Range from before 
the Time Domain 
setting 

RMS of the range set in 
Time Domain 

RMS of the range from
before the Time 
Domain setting 

 

Figure 4.5.7-2 RMS-value calculation range 
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4.6 W-CDMA Downlink Waveform Pattern Generation 

Function 
This function enables the generation of a waveform pattern to be used in 
cases such a W-CDMA reception sensitivity test, by changing some 
W-CDMA-related parameters of the MX269901A HSDPA/HSUPA 
IQproducerTM. 
It is possible to change the scrambling code number and channelization 
code number for a waveform pattern that is provided as a standard 
waveform pattern. 

4.6.1 Activation 
Select W-CDMA Downlink (Standard) from the System menu on the 
common platform screen. The W-CDMA Downlink setting screen is 
displayed separately. 

4.6.2 W-CDMA Downlink setting screen 

  Menu

Tool buttons

Total Power
 display

Normalize Power
button

Status display

 

Figure 4.6.2-1  W-CDMA Downlink setting screen 
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 File menu 
The File menu contains the following items. 

 

Figure 4.6.2-2  Screen when File is selected 

 

 Select Option 
This menu item is enabled only if MS2830A/MS2840A was selected 
in Section 4.1 “Starting/Exiting IQproducerTM”.  

 
Select whether to enable/disable the ARB memory expansion option 
256M samples for the Vector Signal Generator. Selecting With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option 256M 
samples is not installed in the MS2830A or MS2840A, the generated 
waveform pattern may not be able to be used. Waveform patterns 
cannot be created with a size greater than 64Msamples when 
Without Option27 (Memory 256M samples) is selected. Select either 
With Option21 or Without Option21 according to whether the ARB 
memory expansion option 256Msamples is installed to be used. 

 Recall Parameter File 
Sets the W-CDMA Downlink parameters according to the setting of 
the parameter files saved by Save Parameter File. 
 

 Save Parameter File 
Saves the W-CDMA Downlink setting parameters to a file. 
 

 Exit 
Exits the W-CDMA Downlink IQproducerTM. 
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 Edit menu 
The Edit menu contains the following items. 

 

Figure 4.6.2-3  Screen when Edit is selected 

 

 Channel Edit 
Displays the Channel Edit screen in which the P-CCPCH and 
DPCH parameters are set. This is the same operation with clicking 
the Channel Edit button on the screen. 
 

 Calculate Waveform Pattern 
Starts waveform pattern generation based on the settings on the 
screen. 
The number of frames to be generated varies depending on the 
setting conditions for each channel, and the time required for 
generating a waveform pattern also varies accordingly. The number 
of frames to be generated is displayed on the calculation progress 
screen. 
Refer to Appendix B “Number of Frames to Be Generated” in the 
MX269901A HSDPA/HSUPA IQproducerTM Operation Manual for 
details on the number of frames to be generated in accordance with 
the downlink setting conditions. 

 When a normal waveform pattern is generated, two files with the 
extensions “.wvi” and “.wvd” are created. When transferring a 
waveform pattern or loading a waveform pattern to a memory, 
select the *.wvi file for the target waveform pattern. 

 Refer to Appendix B “Number of Frames to Be Generated” in the 
MX269901A HSDPA/HSUPA IQproducerTM Operation Manual for 
details about the classification of waveform patterns. 
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 Easy Setup menu 
The Easy Setup menu contains the following item. 
 

 

Figure 4.6.2-4  Screen when Easy Setup – W-CDMA is selected 

 

 Selects the bit rate setting for Reference Measurement Channels 
(RMC) specified in 3GPP TS25.101, TS25.104. 

 
RMC 12.2kbps (for RX test) 
RMC 12.2kbps (for Performance test) 
RMC 64kbps (for Performance test) 
RMC 144kbps (for Performance test) 
RMC 384kbps (for Performance test) 
 

Table 4.6.2-1  Physical channel powers for RMC 12.2 kbps (for RX test) 

Physical 
Channel 

Power ratio 

P-CPICH P-CPICH_Ec/DPCH_Ec = 7 dB 
P-CCPCH  P-CCPCH_Ec/DPCH_Ec = 5 dB 
SCH SCH_Ec/DPCH_Ec = 5 dB 
PICH PICH_Ec/DPCH_Ec = 2 dB 
DPCH DPCH_Ec/Ior = 10.32 dB 
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Table 4.6.2-2  Physical channel powers for channels other than  

RMC 12.2 kbps (for RX test) 

Physical 
Channel 

Power ratio 

P-CPICH P-CPICH_Ec/Ior = 10 dB 
P-CCPCH P-CCPCH_Ec/Ior = 12 dB 
SCH SCH_Ec/Ior = 12 dB 
PICH PICH_Ec/Ior = 15 dB 

DPC
H 

12.2 
kbps DPCH_Ec/Ior = 16.6 dB 

64 kbps DPCH_Ec/Ior = 12.8 dB 
144 
kbps DPCH_Ec/Ior = 9.8 dB 

384 
kbps DPCH_Ec/Ior = 5.5 dB 

OCNS The power where the total of all the channels 
including OCNS is 0 dB. 

 
 Tool buttons 

The following tool buttons are provided: 
 

  Recall Parameter File button 

  Save Parameter File button 

  Calculate Waveform Pattern button 

  Exit button 

 The function of each button is the same with the corresponding item in 
the File or Edit menu. 
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 Total Power display 

 

Figure 4.6.2-5  Total Power display 

 

 The total power of the channels that are set to ON (excluding OCNS) 
is displayed in this field. If the total power displayed here is out of 

0.01 dB when OCNS is OFF, the warning message shown below is 
displayed during total power calculation, prompting to normalize the 
total power. 

 

Figure 4.6.2-6  Waning message 

 

 Normalize Power button 

 

Figure 4.6.2-7  Normalize Power button 

 

 This button is enabled when OCNS is OFF. When this button is 
clicked, the value displayed in Total Power is subtracted from the 
power of each channel that is set to ON. As a result, the total power is 
normalized to 0 dB while retaining the power ratio between channels. 
 

 Status display 

 The status display on the bottom of the screen displays operation 
statuses such as a warning occurred during setting. 
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4.6.3 Details of setting parameters on W-CDMA Downlink setting 

screen 
This section describes the details of the setting items on the W-CDMA 
Downlink setting screen. 

Setting Item Scrambling Code 
Functional Outline Sets the downlink scrambling code number. 
Setting Parameters Setting Range 

Scrambling Code 0 to 8191 
Details The scrambling code set here is applied to the scramble of all the channels 

including CPICH, P-CCPCH, and PICH. Therefore, the primary scrambling 
code number should be set normally for this setting. 
The primary scrambling code number is expressed as follows: 
Primary scrambling code number = 16*i (i = 0 to 511) 

 
Setting Item CPICH 
Functional Outline Performs settings related to CPICH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 (dB), setting resolution: 0.01 dB 

Details The channelization code of the CPICH is fixed to 0. 

 
Setting Item P-CCPCH 
Functional Outline Performs settings related to P-CCPCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 (dB), setting resolution: 0.01 dB 
P-SCH & S-SCH Power 40.00 to 0.00 (dB), setting resolution: 0.01 dB 

Details The channelization code of the P-CCPCH is fixed to 1. 
BCH is mapped for P-CCPCH. 

 
Setting Item PICH 
Functional Outline Performs settings related to PICH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 (dB), setting resolution: 0.01 dB 
Channelization Code 0 to 255 
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Setting Item DPCH 
Functional Outline Performs settings related to Downlink DPCH. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Power 40.00 to 0.00 (dB), setting resolution: 0.01 dB 
Channelization Code 0 to SF  1 

SF (spreading factor) varies depending on the 
setting of Data as follows: 

RMC 12.2 kbps = 128 
RMC 64 kbps = 32 
RMC 144 kbps = 16 
RMC 384 kbps = 8 
AMR1/AMR2/AMR3 = 128 
ISDN = 32 
384 kbps Packet = 8 

Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/ 
RMC 384 kbps/AMR1/AMR2/AMR3/ISDN/ 
384 kbps Packet 

Details The channel coding parameter of the DCH is set according to the standard 
format selected by Data. 

RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps 

Refer to 3GPP TS25.101 Annex A.3 DL reference measurement channel for 
details of these channels. See the next and subsequent pages for details of 
each parameter. 

AMR1/AMR2/AMR3/ISDN 

Refer to 3GPP TR25.944 4.1.1.3 Example for DCH for details of these 
channels. See the sections below for details of DTCH, DCCH, and 
Multiplexing. 

DTCH 

AMR1: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #1) 
AMR2: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #2) 
AMR3: 4.1.1.3.1.2 Example for 12.2 kbps data (TFS = #3) 
ISDN: 4.1.1.3.1.6 Example for 64 kbps data 
 
DCCH 

AMR1/AMR2/AMR3/ISDN: 4.1.1.3.1.1 Example for 3.4 kbps data 
 
Multiplexing 

AMR1/AMR2/AMR3: 4.1.1.3.2.2 Example for multiplexing of 12.2 kbps data 
and 3.4 kbps data 

ISDN: 4.1.1.3.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data
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 DL_RMC_12_2kbps channel coding parameters 

Table 4.6.3-1  DL reference measurement channel 12.2 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 12.2 
DPCH ksps 30 
Slot Format #i  11 
TFCI  On 
Power offsets PO1, PO2 and PO3 dB 0 
Puncturing % 14.7 

 
Table 4.6.3-2  DL reference measurement channel 12.2 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 244 100 
Transport Block Set Size 244 100 
Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Convolution Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 4.6.3-1  Channel coding for DL reference measurement channel 12.2 kbps 
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 DL_RMC_64kbps channel coding parameters 

Table 4.6.3-3  DL reference measurement channel 64 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 64 
DPCH ksps 120 
Slot Format #i  13 
TFCI  On 
Power offsets PO1, PO2 and PO3 dB 0 
Repetition % 2.9 

 
Table 4.6.3-4  DL reference measurement channel 64 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 1280 100 
Transport Block Set Size 1280 100 
Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
Position of TrCH in radio frame fixed fixed 
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Figure 4.6.3-2  Channel coding for DL reference measurement channel 64 kbps 
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 DL_RMC_144kbps channel coding parameters 

Table 4.6.3-5  DL reference measurement channel 144 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 144 
DPCH ksps 240 
Slot Format #i  14 
TFCI  On 
Power offsets PO1, PO2 and PO3 dB 0 
Puncturing % 2.7 

 
Table 4.6.3-6  DL reference measurement channel 144 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 2880 100 
Transport Block Set Size 2880 100 
Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
Position of TrCH in radio frame fixed fixed 
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Figure 4.6.3-3  Channel coding for DL reference measurement channel 144 kbps 

 



 

Chapter 4  Operations for Each Function 

4-78 

 DL_RMC_384kbps channel coding parameters 

Table 4.6.3-7  DL reference measurement channel 384 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 384 
DPCH ksps 480 
Slot Format #i  15 
TFCI  On 
Power offsets PO1, PO2 and PO3 dB 0 
Puncturing % 22 

 
Table 4.6.3-8  DL reference measurement channel 384 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 3840 100 
Transport Block Set Size 3840 100 
Transmission Time Interval 10 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
Position of TrCH in radio frame fixed fixed 
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Figure 4.6.3-4  Channel coding for DL reference measurement channel 384 kbps 
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Setting Item OCNS 
Functional Outline Sets OCNS ON/OFF. 
Setting Parameters Setting Range 

ON/OFF ON or OFF 
Type 16 Codes 

Details When OCNS is set to ON, the power of OCNS (Orthogonal Channel Noise 
Simulator) is adjusted so that the total power of all the channels that are set 
to ON becomes 0 dB. 

When the total power of all the channels that are set to ON (excluding 
OCNS) exceeds 0 dB while OCNS is set to ON, an error occurs and data 
generation is cancelled. The total power of all the channels that are set to ON 
(excluding OCNS) is displayed in Total Power on the screen. 

To clear this error, set OCNS to OFF or attenuate the power of each channel. 
For example, when P-CCPCH, CPICH, and DPCH are set as follows, the 
total power of the channels except OCNS exceeds 0 dB. OCNS cannot be set 
to ON in this event, and it is regarded as an error. 
An error may occur when the actual total power exceeds 0 dB at the 
thousandth or later places that are not displayed, even if 0.00 dB is displayed 
in Total Power on the screen. 

Total > 0.0 dB 

P-CCPCH = 3.00 dB

CPICH = 3.00 dB

DPCH = 3.00 dB

OCNS = ?
 

When OCNS is set to OFF, click the Normalize Power button to adjust the 
power of each channel so that the total power of all the channels becomes 0 
dB while retaining the power ratio between channels. 

P-CCPCH = 3.00 dB 

CPICH = 3.00 dB 

Normalize

DPCH = 3.00 dB 

P-CCPCH = 4.80 dB

CPICH = 4.80 dB 

DPCH = 4.80 dB  
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Details (Cont’d) OCNS consists of 16-channel (for Performance requirement) DPCH. The 
table below shows the parameters. Refer to 3GPP TS25.101 (Release 5) Table 
C.12 for details. 

OCNS (16 channels) 

Channelization 
Code at SF = 128

Relative Level 
Setting (dB) 

2 1 

11 3 

17 3 

23 5 

31 2 

38 4 

47 8 

55 7 

62 4 

69 6 

78 5 

85 9 

94 10 

125 8 

113 6 

119 0 
 

 

Displayed contents 

An OCNS item Power displays the power of OCNS only. The total of this 
value and the value displayed in Total Power is always 0 dB. 
The Channelization Code and SF (spreading factor) used by OCNS are also 
displayed. 
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4.6.4 Details of setting parameters on Channel Edit screen 
When the Channel Edit button is clicked, the Channel Edit screen shown 
below is displayed. This section describes the details of the setting items 
on this screen. 

 

Figure 4.6.4-1  Channel Edit screen 

 

 OK and Cancel buttons  
The OK and Cancel buttons are provided to close the Channel Edit 
screen after performing setting. 
 

 When OK button is clicked: 
The Channel Edit screen is closed applying the settings. 

 When Cancel button is clicked: 
The Channel Edit screen is closed ignoring the settings. 
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Setting Item P-CCPCH Edit 
Functional Outline Performs settings for P-CCPCH. 
Setting Parameters Setting Range 

SFN Cycle Short (fixed) 
Details This is the cycle of SFN (System Frame Number) that is transmitted by BCH 

mapped to P-CCPCH, and is fixed to Short for the W-CDMA IQproducerTM. 

The cycle of SFN becomes a common multiple of the maximum TTI cycle. 

 

Setting Item DPCH Edit (PhyCH) 
Functional Outline Performs settings for DL-DPCH physical channels. 
Setting Parameters Setting Range 

Timing Offset 0 to 149 
TFCI 0 to 1023 

 
Setting Item DPCH Edit (TrCh Edit) 
Functional Outline Performs settings for TrCH. 
Setting Parameters Setting Range 

Data PN9/PN9fix/PN15fix/16bitRepeat 
Details Data 

Selects the data to be inserted to Information Data of the transport channel. 
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last 
data of a signal and the first data of the next signal are not continuous. 
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4.6.5 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using the IQproducerTM. 

 Saving parameter file 

<Procedure> 

1. Select Save Parameter File from the File menu or click the    
tool button to display the parameter file saving screen shown in 
Figure 4.6.5-1. 

2. Enter a file name in the File name text box and click the Save 
button to save the parameter file. 
When the save destination is not changed in the Save in box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\W_CDMA\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 

 

 

Figure 4.6.5-1  Parameter file saving screen 
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 Reading parameter file 

<Procedure> 

1. Select Recall Parameter File from the File menu or click the   
tool button to display the parameter file reading screen shown in 
Figure 4.6.5-2. 

2. Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file. 

 

 

Figure 4.6.5-2  Parameter file reading screen 
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4.6.6 Generating waveform pattern file 
A waveform pattern file to be used in the Vector Signal Generator option 
can be generated based on the setting values. In the screen shown in 
Figure 4.6.6-2, the waveform pattern name and comments can be entered 
and whether to enable or disable the RRC filter can be set. 
The number of frames to be generated varies depending on the setting 
conditions for each channel, and the time required for generating a 
waveform pattern also varies accordingly. 
Refer to Appendix B “Number of Frames to Be Generated” in the 
MX269901A HSDPA/HSUPA IQproducerTM Operation Manual for details 
on the number of frames to be generated in accordance with the 
downlink setting conditions. 

<Procedure> 

1. Select Calculate Waveform Pattern from the Edit menu or click the 

  tool button. 
At this time, the Warning message shown below appears when 
OCNS is set to OFF and the value of Total Power is out of 0.01 dB. 

 

Figure 4.6.6-1  Warning message 

 

Click the OK button to normalize the Total Power and proceed with  the 
next step. 
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2. The file name input screen is displayed. 

 
File name display area

Output destination folder
selection button

Package name input box

Output file name input box

Comment input box

RRC Filter Off checkbox

 

Figure 4.6.6-2  File name input screen 

 

 Enter a file name in the file name input box within 18 characters. 
1-byte alphanumeric characters and the following symbols can be 
used for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 When a file name is entered, the file to be generated is displayed in 
the file name display area in the following format: 

File name format: 

test_A.wvi

Extension: wvi… Information file (text format)

wvd… Data file (binary format)

Target memory: A… Read from waveform memory A

B… Read from waveform memory B
Entered file name  

 Enter a comment for the waveform pattern in a comment input box. 
Three comment input boxes are provided, and a comment can be 
entered in each line within 38 characters. 
1-byte alphanumeric characters and symbols can be used for 
comments. 
The contents of each comment are displayed on the screen when the 
corresponding waveform pattern is selected by the Vector Signal 
Generator option. Leave the comment boxes blank if not necessary. 
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 When the RRC Filter Off check box is selected, symbol data that 
does not pass through the RRC filter is generated as a waveform 
pattern. You don’t need to select this check box under normal 
conditions. 

3. Click the OK button to start waveform pattern file generation. 
The calculation progress screen is displayed during the file 
generation progressing. 

Dialog box

Progress bar

 

Figure 4.6.6-3  Calculation progress screen 

 

 The file generation processing statuses are displayed in the dialog 
box. The file generation progress status is indicated by the progress 
bar. 

When started with MS269x, MS2830A, or MS2840A and when 
MS269x or MS2830/MS2840 is selected in the Select instrument 
screen, waveform pattern files generated by this application are 
saved in the following directory: 

Installed OS Export destination folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\ 
Signal Analyzer\System\Waveform 

 
 In other cases, the output destination folder can be selected from the 

Browse for Folder screen shown in Figure 4.6.6-4, which is displayed 
by clicking the output destination folder selection button on the 
Output File Name screen (see Figure 4.6.6-2). 
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Figure 4.6.6-4  Browse for Folder screen 

 

 When the output destination folder is not specified, waveform 
pattern files are saved in the following directory: 
X:\IQproducer\W_CDMA\Data 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
 

Note: 

The W-CDMA Uplink IQproducer waveform pattern file generation 
and the W-CDMA Downlink IQproducer waveform pattern file 
generation must be operated exclusively. An error dialog box will 
be displayed if the W-CDMA Uplink IQproducer waveform pattern 
file generation is started while the W-CDMA Downlink IQproducer 
waveform pattern file generation is operating, and vice versa. To 
start the W-CDMA Uplink/Downlink IQproducer waveform pattern 
file generation while the other is operating, cancel the other file 
generation or wait until the other file generation is completed. 
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4.6.7 Auxiliary signal output 
When a waveform pattern generated by the W-CDMA Downlink 
IQproducerTM is selected by the Vector Signal Generator option, a marker 
signal synchronized with the RF signal is output from the AUX connector 
on the rear panel as an auxiliary signal. Refer to the 
MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector Signal 
Generator Operation Manual (Operation) for details on the AUX 
connector. Frame Pulse (Marker 1) is output. 

 Frame Pulse 
A 10-ms cycle pulse synchronized with the symbol at the beginning of 
the frame is output from Marker 1. The signal polarity can be changed 
by changing the polarity of Marker 1. 
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4.7 W-CDMA Uplink Waveform Pattern Generation 

Function 
This function enables the generation of a waveform pattern to be used in 
cases such a W-CDMA reception sensitivity test, by editing some 
W-CDMA-related parameters of the MX269901A HSDPA/HSUPA 
IQproducerTM. 
It is possible to change the scrambling code number and channelization 
code number for a waveform pattern that is provided as a standard 
waveform pattern. 

4.7.1 Activation 
Select W-CDMA Uplink (Standard) from the System menu on the 
common platform screen. The W-CDMA Uplink setting screen is 
displayed separately. 

4.7.2 W-CDMA Uplink setting screen 

  
Menu

Tool buttons

Normalize Power
button

 

Figure 4.7.2-1  W-CDMA Uplink setting screen 
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 File menu 
The File menu contains the following items. 

 

Figure 4.7.2-2  Screen when File is selected 

 

 Select Option 
This menu item is enabled only if MS2830A/MS2840A was selected 
in 4.1 “Starting/Exiting IQproducerTM”.  

 
Select whether to enable/disable the ARB memory expansion option 
256M samples for the Vector Signal Generator. Selecting With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option 256M 
samples is not installed in the MS2830A or MS2840A, the generated 
waveform pattern may not be able to be used. Waveform patterns 
cannot be created with a size greater than 64Msamples when 
Without Option27 (Memory 256M samples) is selected. Select either 
With Option21 or Without Option21 according to whether the ARB 
memory expansion option 256Msamples is installed to be used. 

 

 Recall Parameter File 
Sets the W-CDMA Uplink parameters according to the setting of the 
parameter files saved by Save Parameter File. 
 

 Save Parameter File 
Saves the W-CDMA Uplink setting parameters to a file. 
 

 Exit 
Exits the W-CDMA Uplink IQproducerTM. 
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 Edit menu 
The Edit menu contains the following items. 

 

Figure 4.7.2-3  Screen when Edit is selected 

 

 Channel Edit 
Displays the Channel Edit screen in which the DPCH parameters 
are set. This is the same operation with clicking the Channel Edit 
button on the screen. 
 

 Channel Gain Setup 
Displays the Channel Gain Setup screen in which the power of each 
channel can be set using c and d parameters. The setting of Power 
in the main screen is changed in accordance with the channel power 
set in this screen. 
 

 Calculate Waveform Pattern 
Starts waveform pattern generation based on the settings on the 
screen. 
The number of frames to be generated varies depending on the 
setting conditions for each channel, and the time required for 
generating a waveform pattern also varies accordingly.  
The number of frames to be generated is displayed on the 
calculation progress screen. 
Refer to Appendix B “Number of Frames to Be Generated” in the 
MX269901A HSDPA/HSUPA IQproducerTM Operation Manual for 
details on the number of frames to be generated in accordance with 
the uplink setting conditions. 
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 Tool buttons 
The following tool buttons are provided: 
 

  Recall Parameter File button 

  Save Parameter File button 

  Calculate Waveform Pattern button 

  Exit button 

 The function of each button is the same with the corresponding item in 
the File or Edit menu. 
 

 Normalize Power button 

 

Figure 4.7.2-4  Normalize Power button 

 

 When this button is clicked, Total Power is subtracted from the power 
of each channel that is set to ON. As a result, the total power is 
normalized to 0 dB while retaining the power ratio between channels. 
The total power value displayed in Total Power is calculated from the 
total power of all the channels that are set to ON. 

 



 

4.7 W-CDMA Uplink Waveform Pattern Generation Function 

4-95 

4 

O
peration

s for E
ach

 F
u

n
ction

 

4.7.3 Details of setting parameters on W-CDMA Uplink setting screen 
This section describes the details of the setting items on the W-CDMA 
Uplink setting screen. 

Setting Item Scrambling Code 
Functional Outline Sets the scrambling code. 
Setting Parameters Setting Range 

Scrambling Code 0 to 16777215 

 
Setting Item UL-DPCCH, UL-DPDCH 
Functional Outline Performs settings for DPCCH and DPDCH. 
Setting Parameters Setting Range 

Power 40.00 to 0 (dB) 
Data RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/ 

RMC 384 kbps/AMR1/AMR2/AMR3/ISDN/ 
64 kbps Packet 

Details RMC 12.2 kbps/RMC 64 kbps/RMC 144 kbps/RMC 384 kbps 

The channel coding parameter of the DCH is set according to the standard 
format selected by Data. 

Refer to 3GPP TS25.104 Annex A UL reference measurement channel for 
details of these channels. See the next and subsequent pages for details of 
each parameter. 

AMR1/AMR2/AMR3/ISDN 

Refer to 3GPP TR25.944 4.1.2.2 Example for DCH for details of these 
channels. See the sections below for details of DTCH, DCCH, and 
Multiplexing. 

DTCH 

AMR1: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #1) 
AMR2: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #2) 
AMR3: 4.1.2.2.1.2 Example for 12.2 kbps data (TFS = #3) 
ISDN: 4.1.2.2.1.6 Example for 64 kbps data 
 
DCCH 

AMR1/AMR2/AMR3/ISDN: 4.1.2.2.1.1 Example for 3.4 kbps data 
 
Multiplexing 

AMR1/AMR2/AMR3: 4.1.2.2.2.2 Example for multiplexing of 12.2 kbps data 
and 3.4 kbps data 

ISDN: 4.1.2.2.2.5 Example for multiplexing of 64 kbps data and 3.4 kbps data
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 UL_RMC_12_2kbps channel coding parameters 

Table 4.7.3-1  UL reference measurement channel 12.2 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 12.2 
DPDCH kbps 60 
DPCCH kbps 15 
DPCCH Slot Format #i  0 
DPCCH/DPDCH power ratio dB 2.69 
TFCI  On 
Repetition % 22 

 
Table 4.7.3-2  UL reference measurement channel 12.2 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 244 100 
Transport Block Set Size 244 100 
Transmission Time Interval 20 ms 40 ms 
Type of Error Protection Convolution Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 4.7.3-1  Channel coding for UL reference measurement channel 12.2 kbps 
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 UL_RMC_64kbps channel coding parameters 

Table 4.7.3-3  UL reference measurement channel 64 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 64 
DPDCH kbps 240 
DPCCH kbps 15 
DPCCH Slot Format #i  0 
DPCCH/DPDCH power ratio dB 5.46 
TFCI  On 
Repetition % 19 

 
Table 4.7.3-4  UL reference measurement channel 64 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 2560 100 
Transport Block Set Size 2560 100 
Transmission Time Interval 40 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 4.7.3-2  Channel coding for UL reference measurement channel 64 kbps 
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 UL_RMC_144kbps channel coding parameters 

Table 4.7.3-5  UL reference measurement channel 144 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 144 
DPDCH kbps 480 
DPCCH kbps 15 
DPCCH Slot Format #i  0 
DPCCH/DPDCH power ratio dB 9.54 
TFCI  On 
Repetition % 8 

 
Table 4.7.3-6  UL reference measurement channel 144 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 2880 100 
Transport Block Set Size 5760 100 
Transmission Time Interval 40 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 
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Figure 4.7.3-3  Channel coding for UL reference measurement channel 144 kbps 
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 UL_RMC_384kbps channel coding parameters 

Table 4.7.3-7  UL reference measurement channel 384 kbps  

physical channel parameters 

Parameter Unit Level 

Information bit rate kbps 384 
DPDCH kbps 960 
DPCCH kbps 15 
DPCCH Slot Format #i  0 
DPCCH/DPDCH power ratio dB 9.54 
TFCI  On 
Puncturing % 18 

 
Table 4.7.3-8  UL reference measurement channel 384 kbps  

transport channel parameters 

Parameter DTCH  DCCH  

Transport Channel Number 1 2 
Transport Block Size 3840 100 
Transport Block Set Size 15360 100 
Transmission Time Interval 40 ms 40 ms 
Type of Error Protection Turbo Coding Convolution Coding 
Coding Rate 1/3 1/3 
Rate Matching attribute 256 256 
Size of CRC 16 12 

 



 

4.7 W-CDMA Uplink Waveform Pattern Generation Function 

4-103 

4 

O
peration

s for E
ach

 F
u

n
ction

 

9525

DCCHDTCH

960kbps DPDCH

 Turbo Code R=1/3

1 2 15

Radio frame FN=4N+1 Radio frame FN=4N+2 Radio frame FN=4N+3Radio frame FN=4N

Information data

CRC attachment

Rate matching

2nd  interleaving

9600

640

1

• • • •

9525 75

9600 9600 9600

46320

46320

15424
Termination 4x12

CRC16

2560

112

Tail8
100

CRC12

1st interleaving

Radio Frame
segmentation

slot segmentation

CRC attachment

Tail bit attachment

 Conv. coding R=1/3

1st interleving

#1  11580

• • • • • • • • • • • •

• • • •

#2  11580 #3  11580 #4  11580

#1  9525 #2  9525 #3  9525 #4  9525

9525 75 75 9525 75

#1 75

#1 90

360

360

2 15

640 640 640

1 2 15

640 640

1 2 15• • • •

640

1 2 15

640 640

1 2 15• • • •

640

1 2 15

640 640

1 2 15• • • •

256025603840

3840

#2 75

#2 90

#3 75

#3 90

#4 75

#4 90

Information data 100

 

Figure 4.7.3-4  Channel coding for UL reference measurement channel 384 kbps 
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4.7.4 Details of setting parameters on Channel Edit screen 
When the Channel Edit button is clicked, the Channel Edit screen shown 
below is displayed. This section describes the details of the setting items 
on this screen. 

 

Figure 4.7.4-1  Channel Edit screen 

 

 OK and Cancel buttons 
The OK and Cancel buttons are provided to close the Channel Edit 
screen after performing setting. 
 

 When OK button is clicked: 
The Channel Edit screen is closed applying the settings. 

 When Cancel button is clicked: 
The Channel Edit screen is closed ignoring the settings. 
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Setting Item DPCH Edit (PhCH) 
Functional Outline Performs settings for UL-DPCH. 
Setting Parameters Setting Range 

Timing Offset 0 to 149 
TFCI 0 to 1023 

 
Setting Item DPCH Edit (TrCh Edit) 
Functional Outline Performs settings for TrCH of UL-DPCH. 
Setting Parameters Setting Range 

Data PN9/PN9fix/PN15fix/16bitRepeat 
Details Data 

Selects the data to be inserted to Information Data of the transport channel. 
PN9fix/PN15fix is PN9/PN15 data reset at the last data of a signal. The last 
data of a signal and the first data of the next signal are not continuous. 
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4.7.5 Details of setting parameters on Channel Gain Setup screen 
When the Channel Gain Setup is selected from the Edit menu, the 
Channel Gain Setup screen shown below is displayed. This section 
describes the details of the setting items on this screen. 

 

Figure 4.7.5-1  Channel Gain Setup screen 

 

Setting Item Channel Gain 
Functional Outline Performs settings for each channel gain 
Setting Parameters Setting Range 

Beta c 0 to 15 
Beta d 0 to 15 

Details When the OK button is clicked after applying settings to close the Channel 
Gain Setup screen, the settings for each item are converted to dB units and 
displayed in the Channel Edit screen. 
When the Cancel button is clicked, the screen is closed without reflecting the 
settings for each item on the Channel Edit screen. 
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4.7.6 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using IQproducerTM. 

 Saving parameter file 

<Procedure> 

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen shown in 
Figure 4.7.6-1. 

2. Enter a file name in the File name text box and click the Save 
button to save the parameter file. 
When the save destination is not changed in the Save in box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\W_CDMA\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 

 

 

Figure 4.7.6-1  Parameter file saving screen 
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 Reading parameter file 

<Procedure> 

1. Select Recall Parameter File from the File menu or click the   
tool button to display the parameter file reading screen shown in 
Figure 4.7.6-2. 

2. Select a parameter file to be read from the file list, and then click 
the Open button to read the selected parameter file. 

 

 

Figure 4.7.6-2  Parameter file reading screen 
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4.7.7 Generating waveform pattern file 
A waveform pattern file to be used in the Vector Signal Generator option 
can be generated based on the setting values. In the screen shown in 
Figure 4.7.7-2, the waveform pattern name and comments can be entered 
and whether to enable or disable the RRC filter can be set. 
The number of frames to be generated varies depending on the setting 
conditions for each channel, and the time required for generating a 
waveform pattern also varies accordingly. 
Refer to Appendix B “Number of Frames to Be Generated” in the 
MX269901A HSDPA/HSUPA IQproducerTM Operation Manual for details 
on the number of frames to be generated in accordance with the uplink 
setting conditions. 

<Procedure> 

1. Select Calculate Waveform Pattern from the Edit menu or click the 

  tool button. 
 

At this time, the Warning message shown below appears when the 
total power is not normalized by clicking the Normalize Power 
button. 

 

Figure 4.7.7-1  Warning message 

 

Click the OK button to normalize the total power and proceed with 
the next step. 
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2. The file name input screen is displayed. 

 
File name display area

Output destination folder
selection button

Package name input box

Output file name input box

Comment input box

RRC Filter Off checkbox

 

Figure 4.7.7-2  File name input screen 

 

 Enter a file name in the file name input box within 20 characters. 
1-byte alphanumeric characters and the following symbols can be 
used for a file name: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

 When a file name is entered, the file to be generated is displayed in 
the file name display area. 

File name format: 

 test.wvi 

Extension: wvi… Information file (text format) 

wvd… Data file (binary format) 

 

 

Entered file name  

 Enter a comment for the waveform pattern in a comment input box. 
Three comment input boxes are provided, and a comment can be 
entered in each line within 38 characters. 
1-byte alphanumeric characters and symbols can be used for 
comments. 
The contents of each comment are displayed on the screen when the 
corresponding waveform pattern is selected by the Vector Signal 
Generator option. Leave the comment boxes blank if not necessary. 
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 When the RRC Filter Off check box is selected, symbol data that 
does not pass through the RRC filter is generated as a waveform 
pattern. You don’t need to select this check box under normal 
conditions. 

3. Click the OK button to start waveform pattern file generation. 
The calculation progress screen is displayed during the file 
generation processing. 

Dialog box

Progress bar

 

Figure 4.7.7-3  Calculation progress screen 

 

 The file generation processing statuses are displayed in the dialog 
box. The file generation progress status is indicated by the progress 
bar. When the file is generated completely, the information about the 
generated waveform pattern file is displayed in the dialog box. 

When started with MS269x, MS2830A or MS2840A and when 
MS269x or MS2830/MS2840 is selected in the Select instrument 
screen, waveform pattern files generated by this application are 
saved in the following directory: 

Installed OS Export destination folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\ 
Signal Analyzer\System\Waveform 

 

 In other cases, the output destination folder can be selected from the 
Browse for Folder screen shown in Figure 4.7.7-4, which is displayed 
by clicking the output destination folder selection button on the 
Output File Name screen (see Figure 4.7.7-2). 
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Figure 4.7.7-4  Browse for Folder screen 

 

 When the output destination folder is not specified, waveform 
pattern files are saved in the following directory: 
X:\IQproducer\W_CDMA\Data 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
 

Note: 

The W-CDMA Uplink IQproducer waveform pattern file generation 
and the W-CDMA Downlink IQproducer waveform pattern file 
generation must be operated exclusively. An error dialog box will 
be displayed if the W-CDMA Uplink IQproducer waveform pattern 
file generation is started while the W-CDMA Downlink IQproducer 
waveform pattern file generation is operating, and vice versa. To 
start the W-CDMA Uplink/Downlink IQproducer waveform pattern 
file generation while the other is operating, cancel the other file 
generation or wait until the other file generation is completed. 
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4.7.8 Auxiliary signal output 
When a waveform pattern generated by the W-CDMA Uplink 
IQproducerTM is selected by the Vector Signal Generator option, a marker 
signal synchronized with the RF signal is output from the AUX connector 
on the rear panel as an auxiliary signal. Refer to the 
MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector Signal 
Generator Operation Manual (Operation) for details on the AUX 
connector. Frame Pulse (Marker 1) is output. 

 Frame Pulse 
A 10-ms cycle pulse synchronized with the symbol at the beginning of 
the frame is output from Marker 1. The signal polarity can be changed 
by changing the polarity of Marker 1. 
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4.8 Help Screen 
Click Help on the common platform screen described in section 4.2. 
This screen displays the version information. 
Click OK to close the Help screen. 

The following shows an example. 

 

Figure 4.8-1  Help screen 
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4.9 Time Domain Graph Display 
The time domain waveform of a waveform pattern can be displayed in a 
graph. 

4.9.1 Activation 
Select Time Domain from the Simulation & Utility tab on the common 
platform screen. The time domain graph display screen is displayed 
separately.  
 

4.9.2 Time domain graph display screen 

 Menu

Legend

Time domain graph
display area

Trace addition/
deletion

Graph display area
setting (Scale)

Mouse interaction
setting

Interaction with signal
generation application

Set RMS Range
button

Marker display area

Cursor position
setting

Graph type

Marker Edit button

 

Figure 4.9.2-1  Time domain graph display screen 

 

 Description of items in time domain graph display screen 

(1) Menu 
Trace addition, trace deletion, Marker Edit dialog box open, and 
time domain graph display close can be executed. 

(2) Graph Type 
The graph type can be selected from the drop-down list. Two graph 
types can be selected: “I, Q, Marker” and “Power, Marker”. 

(3) Legend 
File name display for an added trace, selection of a displayed trace, 
and selection of a trace to be added/deleted can be executed. 
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(4) Time domain graph display area 
A time domain graph is displayed in this area. Graph cursor move 
and graph zoom-in display can be executed. 

(5) Add/Delete (trace addition/deletion) 
A trace can be added/deleted. 

(6) Cursor Position 
The graph cursor position in the time domain graph display area can 
be specified by entering a value in the Time text box. 

(7) Mouse Interaction 
The mouse operation in the time domain graph display area can be 
set to either the graph cursor move function or the zoom-in function. 

(8) Quick Add Mode (interaction with signal generation application) 
Settings for displaying a trace of a waveform pattern generated by a 
signal generation application to the time domain display in 
conjunction with the signal generation application are configured. 

(9) Marker Edit (Marker Edit dialog box open) 
Clicking this button opens the Marker Edit dialog box. 

(10) Marker display area 
The value of each marker is displayed in this area. 

(11) Set RMS Range button 
When the Time Domain screen is displayed from the Convert screen, 
this button is used to set the RMS-calculation range.  
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4.9.3 Displaying time domain graph by reading file 
A waveform pattern can be read and displayed in a time domain graph. 

 Time domain graph display using Add button 

<Procedure> 

1. Click one of the option buttons in the Legend dialog box to select the 
trace color of the waveform pattern in the CCDF graphical area.  

 

Figure 4.9.3-1  Selecting radio button in Legend 

 

2. Click the Add button. 

The Add button is disabled when any other waveform pattern is 
already specified on the selected option button. In such a case, delete 
the waveform pattern by clicking the Delete button, or click one of 
other option button.  

 

Figure 4.9.3-2  Add button 

 

 Otherwise, select Add Trace from the File menu. 

 

Figure 4.9.3-3  Add Trace in File menu 
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3. Click the  button in the Add Trace screen, and select a 
waveform pattern for which a time domain graph is displayed. 

 

Figure 4.9.3-4  Add Trace screen 

 

 Waveform pattern files that have the formats below can be read. For 
details about the ASCII1, ASCII2, ASCII3, and 
MS269x/MS2830A/MS2840A Digitizer formats, see Section 4.5.6 
“Input file format”.  

 ASCII1 

 ASCII2 

 ASCII3 

 MS269x/MS2830A/MS2840A Digitizer 

 wvi 
Also, a maximum of 1 Msample (= 1,048,576 samples) can be read. 

 When a waveform pattern is selected, either the data of the selected 
waveform pattern or “1 Msample” is displayed in the Sampling 
Points text box. The number of reading data can be changed by 
editing the value in the Sampling Points text box. Also, the 
waveform pattern reading start position can be specified by 
changing the value in the Sampling Range text box. If the ASCII1, 
ASCII2, or ASCII3 format was selected for waveform pattern display, 
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enter a value for Sampling Rate.  
 

4. Click the OK button on the Add Trace screen to read the waveform 
pattern. 
When the waveform pattern has been read completely, the time 
domain graph display screen is displayed again with a trace in the 
color selected in Legend. 

 

4.9.4 Deleting time domain graph 
The time domain graph displayed in the screen can be deleted. 

 Deleting time domain graph using Delete button 

<Procedure> 

1. Click the option button in the Legend dialog box to select the trace to 
be deleted.  

 

Figure 4.9.4-1  Selecting radio button in Legend 

 

2. Click the Delete button to delete the graph corresponding to the 
selection in the Legend field. 

 

Figure 4.9.4-2  Delete button 

 

 Otherwise, select Delete Trace from the File menu. 

 

Figure 4.9.4-3  Delete Trace in File menu 
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4.9.5 Graph type 
When “I, Q, Marker” is selected from the Graph Type drop-down list, the 
time domain waveform of the I-phase, Q-phase, and marker data of the 
selected waveform pattern is displayed. 
When “Power, Marker” is selected, the time domain waveform of the 
marker data and the power based on the rms value (written in the wvi 
file) of the selected waveform pattern is displayed. 

When “I, Q, Marker”
is selected

When “Power, Marker”
is selected

 

Figure 4.9.5-1  Time domain graph display according to Graph Type setting 
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4.9.6 Sampling information display 
The sampling information on the trace selected by a radio button in the 
Legend field is displayed in the lower area of the Legend field. 

The reading start sample and the reading end sample are displayed for 
Sampling Range (the first sample is “0”). 
The sampling rate of the waveform pattern to be read is displayed for 
Sampling Rate. 
The number of read samples is displayed for Sampling Points. 
The data point of the reading target waveform pattern is displayed for 
Data Points. 

 

Figure 4.9.6-1  Trace sampling information 
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4.9.7 Selecting mouse interaction in time domain graph display area 
Graph cursor move or graph zoom-in can be selected for a mouse 
dragging operation in the time domain graph display area.  

Click the Mouse Interaction button to display the Mouse Interaction 
dialog box.  

Cursor The mouse is used to move the cursor.  

Zoom The mouse is used to set the zooming area.  

 

Figure 4.9.7-1  Mouse Interaction Dialog Box 
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4.9.8 Moving graph cursor 
The graph cursor displayed in the time domain graph display area can be 
moved. 

 Moving graph cursor using mouse 

When the black-line or yellow-line cursor in the Time Domain graph 
display area is dragged, the cursor is moved. 

 

Figure 4.9.8-1  Graph cursor in time domain graph display area 

 

The contents displayed in Cursor in the time domain graph display 
screen are updated as the graph cursor is moved. 
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 Moving graph cursor changing Cursor value 

When the Time 1 value in the Cursor area of the Time Domain graph 
display screen is updated, the black-line cursor moves and the 
Magnitude 1 value is updated.  
Similarly, when the Time 2 value is updated, the yellow-line cursor 
moves and the Magnitude 2 value is updated.  
When the black-line or yellow-line cursor is moved by changing the Time 
1 or Time 2 value, respectively, the Time delta and 1/delta values are 
updated. Time delta displays the result of subtracting the Time 1 value 
from the Time 2 value, and 1/delta displays the reciprocal of the Time 
delta value.  

 

Figure 4.9.8-2  Cursor input 
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4.9.9 Changing graph scale 
The scale of the graph currently displayed can be changed. 

 Changing graph display area scale 

The scales for the time (X axis) and amplitude (Y axis) of the time 
domain graph display area are updated by changing the value(s) in the 
Scale field on the time domain graph display screen. 
The values set in the Time text boxes (X axis) indicate the range of the 
sampled data displayed in a graph, and 0.0 ms represents the start of 
that data. 

 

Figure 4.9.9-1  Scale input 

 

<Procedure> 

1. Click the Time text box and enter values from the keyboard to 
specify the time display range. 

2. Click the Magnitude text box and enter values from the keyboard to 
specify the amplitude display range. 

When the focus is moved to another control after changing the value(s) in 
the Time text box as shown in Step 1 above, the scale for the X axis in the 
time domain graph display area is updated. 

Similarly, when the focus is moved after changing the value in the 
Magnitude text box as shown in Step 2 above, the scale for the Y axis in 
the time domain graph display area is updated. 

In addition, the scale of both axes can be adjusted to display the entire 
Time Domain graph by clicking the Full Scale button.  
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Figure 4.9.9-2  Graph scale change by mouse operation 

 

 Specifying display area by mouse operation 

When Zoom is selected for Mouse Interaction, pointing and dragging an 
area in the time domain graph enlarges the selected area (within the 
dotted rectangle). 
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4.9.10 Values displayed on graph 
This section describes how a trace on the I, Q, Power, and Marker graphs 
displays the data or marker of the waveform pattern, separately for each 
graph type. 

 I and Q graphs 

On the I and Q graphs (displayed when “I, Q, Marker” is selected from 
the Graph Type drop-down list), the sample values of the read waveform 
pattern are plotted and adjacent samples are connected by linear 
interpolation. 
Note that the sample-unit time scale above the I graph applies only to 
the trace selected by Legend, while the ms-unit time scale below the Q 
graph applies to any displayed traces. 

 

Figure 4.9.10-1  I and Q graph example 

 

 Power graph 

On the Power graph (displayed when “Power, Marker” is selected from 
the Graph Type drop-down list), the sample values of the read waveform 
pattern are plotted as power and adjacent samples are connected by 
linear interpolation. 
If ASCII1, ASCII2, ASCII3, or wvi is selected as the file format for 
waveform pattern display, The X axis of the Power graph is displayed 
with the RMS value of the waveform pattern as 0 dB. When the 
MS2690A/MS2691A/MS2692A or MS2830A/MS2840A actually outputs a 
modulation signal, therefore, the output modulation signal is based on 0 
dB of the Power graph.  

Output level of MS2690A/MS2691A/MS2692A or MS2830A/MS2840A  

= Display level of MS2690A/MS2691A/MS2692A or MS2830A/MS2840A  
 + Level on Power graph 

If MS269/MS2830A/MS2840A Digitizer is selected as the file format for 
waveform pattern display, the level recorded in the digitized file is 
displayed as is. Therefore, when this equipment is actually used to 
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output a modulated signal, the output signal does not necessarily use the 
0 dB in the Power graph as a reference.  

Note that the sample-unit time scale above the Power graph applies only 
to the trace selected by Legend, while the ms-unit time scale below the 
Power graph applies to any displayed traces. 

 

Figure 4.9.10-2  Power graph example 

 

 Marker graph 

On the Marker graph, Markers 1, 2, 3, and RF Gate of the samples of the 
trace selected by Legend are displayed. Marker graphs are traced in a 
staircase pattern, where a line is drawn from a plotted point to the right. 
At Sample 115200 in Figure 4.9.10-3, for example, Marker 1 is 0 (LO), 
Markers 2 and 3 are 1 (HI), and RF Gate is 1 (RF On). 
Note that the sample-unit time scale above the Marker graph applies 
only to the trace selected by Legend, while the ms-unit time scale below 
the Marker graph applies to any displayed traces. 

 

Figure 4.9.10-3  Marker graph example 
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4.9.11 Interaction with signal generation application (Quick Add Mode) 
The method for updating the time domain graph display in conjunction 
with waveform pattern generation by a signal generation application can 
be set and changed. This function is enabled only when the time domain 
graph display function is activated. 

 

Figure 4.9.11-1  Quick Add Mode 

 

 When Add is selected: 

A trace is added to the time domain graph when Time Domain is selected 
from the Simulation menu or the Time Domain tool button is clicked 
after data generation by the signal generation application. Note that the 
time domain graph display will not be updated when the four traces are 
all used. 
 
 When Clear is selected: 

A trace is deleted from the time domain graph and the time domain 
graph of the generated data is displayed when Time Domain is selected 
from the Simulation menu or the Time Domain tool button is clicked 
after data generation by the signal generation application. 
 
 When Off is selected: 

The time domain graph display will not be updated even when Time 

Domain is selected from the Simulation menu or the Time Domain tool 
button is clicked after data generation by the signal generation 
application. 
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4.9.12 Marker edit function 
A new waveform pattern can be created by reading an existing waveform 
pattern and editing the marker data and name with the marker edit 
function.  
The marker edit function cannot be used if ASCII1, ASCII2, ASCII3, or 
MS269x/MS2830A/MS2840A Digitizer was selected as the file format for 
waveform pattern display.  

Note:  

When the waveform pattern bit width is 16 bits, the marker edit 
function is not available.  

 

Create button for 

waveform

Close button for closing
Marker Edit dialog box

Marker name

Marker data 

RF Gate setting

Browse button for 
waveform

Waveform pattern information

 

Figure 4.9.12-1  Marker Edit dialog box 

 

 Description of items in Marker Edit dialog box 

Waveform pattern information 
Information about the read waveform pattern is displayed.  

Browse button for waveform pattern selection 
Clicking this button displays the dialog box for selecting a waveform 
pattern to be read. 

Marker name setting 
The name of each marker can be specified. 

Marker data setting 
Select or clear the Data Edit check box to specify whether to edit the 
data of the corresponding marker. 
When it is cleared, marker data edit is disabled and the marker data 
of the read waveform pattern is used as is. 
When it is selected, marker data edit is enabled, and the marker 
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data with the values set in the Start Point, Width, and Period text 
boxes are added to the new waveform pattern to be created. 

 Set the number of samples prior to the first marker signal output 
starting point to Start Point, the number of samples to output 
marker signals to Width, and the number of samples between the 
marker signal output starting points to Period. 

 

Start Point Width

Waveform pattern

Marker (RF Gate)

Width Width 

Period Period Period  

Figure 4.9.12-2  Parameters for setting Marker and RF Gate data 

 

RF Gate setting 
Select or clear the Data Edit check box to specify whether to edit the 
RF Gate data. 
When it is cleared, RF Gate data edit is disabled and the RF Gate 
data of the read waveform pattern is used as is. 
When it is selected, RF Gate data edit is enabled, and the RF Gate 
data with the values set in the Start Point, Width, and Period text 
boxes are added to the new waveform pattern to be created. 
Set the number of samples prior to the first RF Gate data output 
starting point to Start Point, the number of samples to output RF 
Gate data to Width, and the number of samples between the RF 
Gate data output starting points to Period. 

Create button (for waveform pattern generation) 
This button is used to create a new waveform pattern according to 
the parameters set in the Marker Edit dialog box. Click the Create 
button to display the Export File dialog box, and then specify the 
output folder, output waveform pattern name, and package name in 
this dialog box. 

When started with MS269x, MS2830A or MS2840A and when 
MS269x or MS2830/MS2840 is selected in the Select instrument 
screen, waveform pattern files generated by this application are 
saved in the following directory: 

Installed OS Export destination folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\ 
Signal Analyzer\System\Waveform 
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Close button (for closing Marker Edit dialog box) 
Click this button to close the Marker Edit dialog box. 
 

Refer to Section 4.5.6 “Input file format” for details on marker data and 
RF Gate data. 
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4.9.13 Displaying the Time Domain screen from the Convert screen 
By displaying the Time Domain screen from the Convert screen, the 
pre-conversion waveform pattern can be checked and the range for RMS 
calculation during conversion can be specified.  
However, when the Time Domain screen is displayed from the Convert 
screen, traces cannot be added or deleted.  

On the Time Domain screen, to specify the RMS-calculation range used 
for waveform conversion on the Convert screen, use the black-line and 
yellow-line cursors.  

 

Calculate the RMS using this 

range.  

Figure 4.9.13-1  Setting the RMS-calculation range 

 

After specifying the RMS-calculation range by using the black-line and 
yellow-line cursors, click the Set RMS Range button to specify the 
RMS-calculation range used when converting the waveform pattern on 
the Convert screen and close the Time Domain screen.  

 

 

Figure 4.9.13-2  Set RMS Range button 
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4.10 Clipping Function 
This function performs clipping processing for a waveform pattern 
generated by each signal generation application. Filter, bandwidth, and 
number of repetition times must be set to generate a clipping-processed 
waveform pattern. The generated waveform pattern consists of a 
waveform information file (text format file with the extension “.wvi”) that 
stores the information related to the waveform pattern and a waveform 
data file (binary format file with the extension “.wvd”). 

4.10.1 Activation 
Select Clipping from the File Gen. menu on the common platform screen. 
The Clipping setting screen is displayed separately. 

4.10.2 Clipping setting screen 
The parameters related to clipping processing can be set in the Clipping 
setting screen. 

 

Menu bar 

Toolbar 

(1) 

(2) (4) (3) 

(5) 

(6) 

 

Figure 4.10.2-1  Clipping setting screen 
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 Menu bar 

The following menus are provided on the menu bar. 
 

 The File menu contains the following item. 

 Exit 

Exits from the Clipping. 
 

 The Simulation menu contains the following items. 

 CCDF 

Displays the CCDF graph display screen. 
The CCDF of a generated waveform pattern is displayed in a 
graph. 

 FFT 

Displays the FFT graph display screen. 
The spectrum where FFT processing is performed for a generated 
waveform pattern is displayed in a graph. 

 Time Domain 

Displays the time domain graph display screen. 
The time domain waveform of a generated waveform pattern can 
be displayed in a graph. 
 

 The Edit menu contains the following item. 

 Calculation 

Performs waveform pattern generation. 

 Tool bar 
The following tool buttons are provided on the tool bar. The function of 
each button is the same as the corresponding item in the menus. 

 

  Calculation button 

 CCDF button 

 FFT button 

 Time Domain button 

  Exit button 
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 Description of items on Clipping setting screen 

(1) Reference button 
Select the wvi file of the target waveform pattern. 

(2) Filter Type 
Set the filter type. 

Setting options: Ideal, None, Nyquist, Root Nyquist, Gaussian 

Initial setting: Ideal 

Ideal indicates a low-pass filter, which suppresses the ripple to 0.01 
dB or less within the range from 0.475  Bandwidth to +0.475  
Bandwidth if Sampling Rate/Bandwidth is 50 or less. 

(3) Roll Off/BT 
Set the roll off ratio. This is enabled when Filter Type is set to 
Nyquist, Root Nyquist, or Gaussian. 
Setting range: 0.10 to 1.00 
Setting resolution: 0.01 
Initial value: 0.50 

(4) Bandwidth 
Set the bandwidth. 
Setting range: Sampling Rate/1000 or 0.00100000 (whichever is 
 smaller) to Sampling Rate 
Setting resolution: 0.00000001 
Initial value: Bandwidth of the waveform pattern specified in the  
 Input File text box 

(5) Threshold Level 
Set the threshold level for clipping. 
Setting range: 0.0 to 20.0 
Setting resolution: 0.1 
Initial value: 10.0 

(6) Repetition 
Set the number of times to repeat clipping and filtering. 
Setting range: 1 to 20 
Setting resolution: 1 
Initial value: 10 
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4.10.3 Setting method 
<Procedure> 

1. Click the  button to select the wvi file of the waveform 
pattern to be used. The full path of the selected wvi file is displayed 
in the Input File text box. 

2. Set values in the Filter Type, Roll Off/BT, Bandwidth, Threshold 

Level, and Repetition text boxes.  

3. Select Calculation from the Edit menu or click the  button to 
complete setting. 
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4.10.4 Generating waveform pattern 
When the parameter setting has been completed in the Clipping setting 
screen, select Calculation from the Edit menu or click the  button to 
display the Export File screen shown in Figure 4.10.4-1. In this screen, 
set the waveform pattern export destination, package name, and file 
name, and then enter a comment (if necessary) to generate a 
clipping-processed waveform pattern. The Comment text box can be left 
blank for waveform pattern generation. 

 

(1)

(2)

(3)

(4)

(5) (6)

 

Figure 4.10.4-1  Export File screen 

 

 Description of items in Export File window 

(1) Browse button 
Click this button to select the output destination folder of the 
clipping-processed waveform pattern file. 
When started with MS269x, MS2830A or MS2840A and when MS269x or 
MS2830/MS2840 is selected in the Select instrument screen, waveform 
pattern files generated by this application are saved in the following 
directory: 

Installed OS Export destination folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\Signal 
Analyzer\System\Waveform 
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(2) Package 
Enter the name of the package of the clipping-processed waveform 
pattern to be generated. Up to 31 characters can be entered for a 
package name. Alphanumeric characters and the following symbols 
may be used: 
! % & ( ) + = ` { } _ - ^ @ [ ] 

(3) Export File Name 
Enter the name of the clipping-processed waveform pattern file to be 
generated (common to wvi and wvd files). Up to 20 characters can be 
entered. The usable characters are the same as those for the 
package name. 

(4) Comment 
The comment entered here is displayed in the Comment area on the 
MS2690A/MS2691A/MS2692A or MS2830A/MS2840A screen when 
the clipping-processed waveform pattern to be generated is output 
from the MS2690A/ MS2691A/MS2692A or MS2830A/MS2840A. Up 
to 38 characters can be entered. 
When the Export File screen is displayed for the first time, the 
settings of Filter Type and Threshold Level are initially displayed in 
the upper and middle lines, respectively. Edit them, if necessary. 

(5) OK 
Click this button to start clipping-processed waveform pattern 
generation. 

(6) Cancel 
Click this button to close the Export File screen and return to the 
setting screen. 
 

<Procedure> 

1. The output destination of the clipping-processed waveform pattern 
file is displayed in the Export Path text box. 

2. Set the name of the package of the clipping-processed waveform 
pattern in the Package text box. 

3. Set the clipping-processed waveform pattern file name in the Export 

File Name text box. 

4. In the Comment text boxes, enter information on the 
clipping-processed waveform pattern to be displayed (if necessary). 

5. Click the OK button to start waveform pattern generation. Click the 
Cancel button to return to the setting screen. 
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6. When waveform pattern generation starts, the waveform generation 
execution screen shown in Figure 4.10.4-2 appears. When the 
Cancel button at the bottom of the screen is clicked, waveform 
generation stops and the setting screen is displayed again. When 
waveform generation completes (when “Calculation Completed” is 
displayed), click the OK button to close the waveform generation 
screen and return to the setting screen. 

 

Figure 4.10.4-2  Waveform generation execution screen 

 

7. The clipping-processed waveform pattern file is generated in the 
destination specified in the Export Path text box, with the file name 
(common to wvi and wvd files) specified in the Export File Name text 
box. 
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4.10.5 Clipping-processed waveform pattern simulation examples 
This section provides a simulation example of the spectrum and CCDF 
graphs of the clipping-processed waveform pattern in Figs 4.10.5-1 and 
4.10.5-2, respectively. In this example, the original waveform pattern is 
generated by the MX269905A Mobile WiMAX IQproducer, and clipping 
processing is performed with the following settings: 
Filter Type: Ideal 
Bandwidth: 10.00000000 (MHz) 
Threshold Level: 8.0 
Repetition: 20 

The red line on Figure 4.10.5-2 indicates the CCDF graph before 
clipping. 

 

Figure 4.10.5-1  Spectrum after clipping processing 
 

 

Figure 4.10.5-2  CCDF graph after clipping processing 
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4.10.6 Details of clipping processing 
During clipping processing, clipping and filtering are performed 
repeatedly, as shown in Figure 4.10.6-1. The clipping processing clips the 
peaks that exceed Threshold Level, referencing on RMSIQ as the basis (0 
dB). Figure 4.10.6-2 shows a schematic diagram of the clipping 
processing at this time. 

RMSIQ that is used as the basis of the clipping processing is calculated 
from the following expression. 

  
n

nn QI
N

22
IQ

1
RMS  

wherein,  is the sum of the target waveform patterns (excluding 
samples for which RF output is set to Off by the RF Gate setting). 

When clipping and filtering are performed, RMSIQ is calculated again, 
and the next clipping processing is performed based on the recalculated 
RMSIQ. 

 

Clipping Filtering 

Repeated for the number specified in Repetition 

 

Figure 4.10.6-1  Clipping processing 

 

 

I 

Q Before clipping

After clipping 

 

Figure 4.10.6-2  Schematic diagram of clipping processing 
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When filtering is performed after clipping, the peak becomes larger than 
that when only clipping is performed (see Figure 4.10.6-3), and the crest 
factor of the generated waveform pattern may exceed the level set by 
Threshold Level. Figure 4.10.6-3 shows a simulation example of the 
CCDF graph where a waveform pattern is generated with Repetition = 1 
and the other parameters are set the same as in Section 4.10.5 
“Clipping-processed waveform pattern simulation examples”.   
For the sake of comparison, Figure 4.10.6-4 shows a CCDF simulation 
example where Repetition is changed to 1, 2, and 20. In this example, it 
can be seen that the crest factor comes closer to the level set by 
Threshold Level as the number of repetition times of clipping and 
filtering increases. 

 

When only 
clipping is 
performed 

Before clipping 

When filtering is 
performed after 
clipping 

 

Figure 4.10.6-3  Comparison among clipping methods (when Repetition = 1) 
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Repetition = 1

Repetition = 2

Repetition = 20

 

Figure 4.10.6-4  CCDF graph when changing Repetition 
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This chapter describes in particular the operating procedures for 
important functions that pertain to the functions that can be operated by 
the IQproducerTM. 
 

5.1 Generating Waveform Pattern ................................... 5-2 
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5.1 Generating Waveform Pattern 
This section describes a series of operations for converting an 
ASCII-format waveform pattern generated by external simulation 
software to a waveform pattern that can be used by the Vector Signal 
Generator option using the Convert function of the IQproducerTM. 

Refer to Section 4.5 “File Conversion on Convert Screen” for details of 
setting parameters. 

<Procedure> 

1. Click the Reference button on the Convert screen and read the file 
to be converted. 

2. The parameters related to the waveform pattern are enabled to be 
input after reading the waveform pattern file. Input these 
parameters as required according to the type and applications of the 
waveform pattern. 

3. Set the sampling rate. 
The sampling rate indicates the speed of reading the waveform 
pattern from an arbitrary waveform memory in the Vector Signal 
Generator option. Note that it is not the speed after processing the 
interpolator within the Vector Signal Generator option. 
When reading a W-CDMA waveform pattern having the over 
sampling of 4, for example, set the sampling rate as follows: 
3.84 Mcps  4 = 15.36 MHz 

4. Set Unit Symbol. 
Set the set unit for Trigger Delay and other parameters of the Vector 
Signal Generator option. The set unit display for Trigger Delay is 
changed depending on this setting. 

5. Set Over Sampling. 
Set the over sampling rate for the waveform pattern to be input. It is 
recommended to use an over sampling rate of at least 1.2. If the over 
sampling rate is less than 1.2, the image signal element may exceed 
–60 dBc. The symbol rate is the output rate for the data that has 
been mapped in the physical channel of each communication system 
before the Route Nyquist processing is performed. The sampling rate 
is calculated by multiplying the symbol rate by the over sampling 
rate. 

6. Set Spectrum. 
The spectrum relationship between the IQ signal and RF signal may 
be reversed according to the modulator configuration and the 
communication system. Set Reverse for IS-95 and cdma2000. 
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7. Enter a comment. 
Enter a comment into the Comment Lines 1/2/3 if necessary. The 
character string entered here is displayed on the screen when the 
corresponding waveform is selected by the Vector Signal Generator 
option. 

8. Set Marker Name. 
Set a name for Makers 1, 2, and/or 3 to be used if necessary. The 
marker output is displayed in the Vector Signal Generator option 
screen with the name specified here when the corresponding 
waveform pattern is selected. 

9. Set Burst Setting. 
The Burst Setting includes two settings: Frame Length and Gap 
Length. The input waveform pattern is divided into frames of the 
number of data set by Frame Length, and a gap (burst off period in 
which the burst wave is not output) of the number of data set by Gap 
Length is inserted between frames (see Figure 5.1-1). 

 It is not necessary any longer to output the burst off period as a 
waveform pattern when using this setting. For example, when 
outputting only the first slot in the system where one frame consists 
of five slots, the memory length required for the waveform pattern is 
reduced to 1/5 of that when the Gap Frame setting is not used. 
When an external trigger signal is used, the Frame Length setting is 
also used to synchronize the external trigger and the signal output 
timing in the Vector Signal Generator option. Refer to Section 2.6.2 
“Setting Start and Frame triggers” in the 
MS2690A/MS2691A/MS2692A or MS2830A/MS2840A Vector Signal 
Generator Operation Manual (Operation) for details. 
Set Gap Length to 0 for continuous waves. 

 

Figure 5.1-1  Frame Length and Gap Length Settings 
 

10. Click the Convert button to start data conversion. 
The converted data output destination and file name are set, and 
waveform pattern generation is started. 
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A list of error messages is shown below. n0, n1, n2, n3, and n4 are numbers. 

Error Message Description 

Platform 
Application is not found from APPINFO 
Manager. 

The application was not found from the application 
information. 

Application is not found. (“Activated 
application name”) — 

Application starting timeout. (“Activated 
application name”) — 

Application termination timeout. 
(“Application name”) Shutdown application? — 

IQproducer is already running. — 
(“Application name”) is already running. — 
Request shutdown was not completed.  
(“Application name”) — 

FFT 

Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
An “IQproducer” is down. 
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

The length of “FFT Points” is longer than that 
of the waveform data. 
Trace data couldn't be read. 
(“File name”) 

— 

The length of “FFT Points” is longer than that 
of the waveform data. 
“FFT Points” was set as suitable value. 
(“File name”) 

— 

Invalid parameter value. — 
There is a request from the other IQproducer 
application for drawing a trace. 
Delete the displayed trace and draw a new 
trace? 

— 

You have filled up all the trace available. 
Delete some traces, or set “Quick Add Mode” 
to “clear” before adding a trace.” 

— 
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Error Message Description 

There is no trace to output. CSV output is impossible since no graph is 
displayed. 

If the “FFT Points” is changed, all the trace 
displayed will be recalculated. 
Are you sure to change the “FFT Points”? 

— 

Sampling Rate is different. 
Do you clear the graph already displayed and 
display new graph? 

— 

If the “Sampling Range” is changed, all the 
trace displayed will be recalculated. Are you 
sure to change the “Sampling Range”? 

— 
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Error Message Description 

Convert 

Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not open file. (“File name”) — 
Can not read file. — 
An “IQproducer” is down. 
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

Can not create the output file. (“File name”) — 
File not found. (“File name”) — 
The detail area is a maximum of 6 lines, 56 
characters per line. (“File name”) — 

Fail to copy the detail file. (“File name”) — 

The read data is shorter than Data Points. 
(“File name”) 

Data conversion is impossible since the input file is 
smaller than the number of data points (Data 
Points). 

The Data Points are too large. The Maximum 
Data Points are 268435456 samples. 

Conversion is not possible because the set Data 
Points value exceeds the maximum number of 
samples.  

The Data Points are too large. The Maximum 
Data Points are either 67108864 samples 
(without Option 27) or 268435456 samples 
(with Option 27). 

Conversion is not possible because the set Data 
Points are longer than the number of maximum 
samples.    

When the Burst Setting checkbox is checked, 
The value of Frame Length must be equal or 
less than the value of Data Points. 

— 

The waveform pattern to be generated should 
be above n0, otherwise it will be clipped. 

Clipping will be performed because the data to 
convert is larger than n0 and has overflowed.  

RMS value of waveform data is not in range n1 
to n2 RMS value. The value will be changed. 

The RMS value for the read waveform pattern will 
be changed because it is outside the setting range 
from n1 to n2.  

The RMS value of this waveform pattern is 
outside the range of n3 to n4. Note that the 
output level accuracy of RF output is not 
guaranteed when the RMS value of a 
waveform pattern is outside the range of n3 to 
n4. 

The output level accuracy of the waveform pattern 
to output is not guaranteed because the RMS value 
of the pattern is outside the range from n3 to n4.  

The dgz file size is too large. The Maximum 
Data Points is 268435456 samples. 

The size of the digitized file exceeds 268,435,456 
samples.  
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Error Message Description 

W-CDMA Downlink/Uplink 

Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
Can not open the parameter file. (“File name”) — 
The Setting value is invalid “Parameter name” — 
The Setting value is out of range 
“(Parameter name (Min – Max.))” — 

Total channel power except OCNS is over 0 
dB. — 

An initial parameter file was not able to be 
read. — 

All Channels are OFF. — 
Input File Name. — 
Value is set up at 800 steps. — 
DTCH information data is changed to the data 
truncated every one frame (PN9fix). — 

Total channel power is not normalized to 0 dB. 
It is necessary to normalize the total power 
when OCNS is OFF. 

— 

Total channel power is not normalized to 0 dB. 
It is necessary to normalize the total power 
when Simulation is UpLink. 

— 

Memory option cannot be turned on in 
MS269x mode. — 
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Error Message Description 

Time Domain 

Initialization error — 
Selection of an inaccurate file. (“File name”) — 
Can not open file. (“File name”) — 
Invalid file format. (“File name”) — 
The data of a Wave-form file is unusual. — 
Can not write file. (“File name”) — 
Can not read file. — 
A “IQProducer” is down. 
Application is shutdown. — 

Can not open the setting file. (“File name”) — 
The Setting value is invalid (“Parameter 
name”) — 

The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

Invalid parameter value. — 
There is a request from the other IQproducer 
application for drawing a trace. 
Delete the displayed trace and draw a new 
trace? 

— 

You have filled up all the trace available. 
Delete some traces, or set “Quick Add Mode” 
to “clear” before adding a trace.” 

— 

If the “Graph Type” is changed, all the trace 
displayed will be recalculated. Are you sure to 
change the “Graph Type”? 

— 

Marker edit function cannot be used because 
the selected file does not include marker 
signal. 

If a 16-bit file is selected:  
The marker editing function cannot be used because 
the file does not include a marker signal.  
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Error Message Description 

Clipping 
Can not open file. — 
Can not write file. — 
Can not read file. — 
Input File is not selected. — 
The Setting value is out of range (“Parameter 
name (minimum value – maximum value)”) — 

The Waveform data file is not generated. — 
Wrong pattern license. — 
This pattern cannot use.  Because, “Internal 
FIR” is used. — 

The number of samples is over 256M samples. — 
Input Package Name. — 
Input Export File Name. — 
The data of a Wave-form file is unusual. — 
Exception error. — 
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